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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking on an enterprise solution consisting of Avaya IP Office Release 11.0 and
Avaya Session Border Controller for Enterprise Release 7.2.2 to interoperate with Ironton SIP
Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Ironton SIP Trunking Service provides PSTN access via a SIP Trunk between the enterprise
and Ironton’s network as an alternative to legacy analog or ISDN-PRI trunks. This approach
generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunking service between Ironton SIP Trunking Service and an Avaya SIP-enabled enterprise
solution.

In the sample configuration, the Avaya SIP-enabled enterprise solution consists of Avaya IP Office
500v2 Release 11.0 (hereafter referred to as IP Office), Avaya Session Border Controller for
Enterprise Release 7.2.2 (hereafter referred to as Avaya SBCE), Avaya Communicator for Windows,
Avaya Communicator for Web, Avaya Equinox for Windows and Avaya Deskphones, including
SIP, H.323, digital, and analog.

The Ironton SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the IP Office solution are able to place and
receive PSTN calls via a broadband WAN connection using the SIP protocol. This converged
network solution is an alternative to traditional PSTN trunks such as analog and/or ISDN-PRI
trunks. This approach generally results in lower cost for the enterprise.

The terms “service provider” and “Ironton” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Solution & Interoperability Test
Lab by connecting IP Office and the Avaya SBCE to Ironton’s SIP Trunking service across the
public internet. The configuration in Figure 1 was used to exercise the features and functionality
tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products only (private network side). Readers should consult the appropriate Avaya product
documentation for further information regarding security and encryption capabilities supported by
those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is the
responsibility of each individual vendor. Readers should consult the appropriate vendor-supplied
product documentation for more information regarding those products.
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2.1 Interoperability Compliance Testing

To verify SIP Trunk interoperability, the following features and functionalities were exercised
during the compliance testing:

SIP Trunk Registration (Dynamic Authentication).

SIP OPTIONS queries and responses.

Incoming calls from the PSTN were routed to the DID numbers assigned by Ironton.
Incoming PSTN calls were terminated to the following endpoints: Avaya 96x1 Series IP
Deskphones (H.323), Avaya 1100 Series IP Deskphones (SIP), Avaya Communicator for
Windows, Avaya Communicator for Web, Avaya Equinox for Windows, Avaya 9508 and
1408 Digital Deskphones, and analog Deskphones.

Outgoing calls to the PSTN were routed via Ironton’s network to various PSTN destinations.
Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper Codec negotiation and two way speech-path. (Testing was performed with codecs:
G.711MU and G.729A, Ironton’s preferred codec order).

No matching codecs.

Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail
messages from PSTN phones).

e Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems).
e Calling number blocking (Privacy).
e Call Hold/Resume (long and short duration).
e Call Forward (unconditional, busy, no answer).
e Blind Call Transfers.
e Consultative Call Transfers.
e Station Conference.
e Mobility twinning of incoming calls to mobile phones.
e Simultaneous active calls.
e Long duration calls (over one hour).
e Proper response/error treatment to all trunks busy.
e Proper response/error treatment when disabling SIP connection.
o T.38 fax.
Note: Remote worker was tested as part of this solution; the configuration necessary to support

remote workers is beyond the scope of these Application Notes and is not discussed in these
Application Notes.

Items not supported or not tested included the following:

e Inbound toll-free calls, Outbound Toll-Free calls, 911 calls (emergency), “0” calls
(Operator), 0+10 digits calls (Operator Assisted) and international calls were not tested.
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2.2 Test Results

Interoperability testing with Ironton was successfully completed with the following
observations/limitations.

SIP OPTION Messages — During the compliance test Ironton did not send SIP OPTION
messages to IP Office, IP Office did send SIP OPTION messages to Ironton, with Ironton
responding with “501 Unsupported Method” instead of a 200 OK, this was sufficient to keep
the SIP trunk up in-service.

Extra SIP messages sent during Call-Forward and Call-Transfers to the PSTN — After a
call from the PSTN to the enterprise was successfully forwarded or transferred back to
another PSTN party using the SIP REFER method, Ironton accepted the SIP REFER messages
sent by IP Office with “202 Accepted”, which resulted in the SIP trunk channels being released
with BYE messages, as expected. After the SIP trunk channels were released IP Office would
send “405 Method Not Allowed” and “487 Request Terminated” with Ironton responding with
“481 Call Leg Does Not Exist”. This behaviour had no negative impact on the transferred call,
SIP trunk resources were released successfully after the call transfer, as expected. It’s being
mentioned here simply as an observation.

Caller ID on calls being forwarded to the PSTN — On calls originated from the PSTN to IP
Office stations with the call-forward feature active in the IP Office station to another PSTN
number, the caller ID number displayed at the terminating PSTN station was always of the
pilot number assigned to the SIP trunk, instead of the originating PSTN number.

SIP endpoints may indicate that a transfer failed even when it is successful —
Occasionally on a transfer operation, Avaya IP Office SIP endpoints (Avaya 1100 Series
Deskphones and Avaya Communicator for Windows) may indicate on the local call display
that the transfer failed even though it was successful. The frequency of this behavior can be
reduced by enabling “Emulate Notify for REFER” on the IP Office SIP Line (Section
5.4.6).

Fax support — Incoming and outgoing fax calls using the G.711 pass-through method failed
during the compliance test. T.38 fax calls were successful in both directions (incoming and
outgoing). The issue may be related to the unpredictability of G.711 pass-through techniques,
which only works well on networks with very few hops and with limited end-to-end delay.
T.38 Fax Transport should be use with this solution.

Conference on Avaya Equinox soft-client — Conference on the Avaya Equinox for
Windows soft-client is not working properly. When the attempt is made to conference active
calls in the Avaya Equinox for Windows soft-client by “merging” the calls together, the
parties are not joined together into conference, instead a new call is made from the first
active call that was held by the Equinox soft-client to the second active call held by the
Equinox soft-client, with the Avaya Equinox soft-client unable to merge the active calls
together into conference. This issue was only seen on the Avaya Equinox for Windows soft-
client. There is no current work-around; if the conference feature is needed on an Avaya soft-
client for IP office the Avaya Communicator for Windows soft-client could be used until this
issue is resolved by Avaya. This issue is under investigation by Avaya.

2.3 Support
For support on Ironton systems visit the corporate Web page at: https://www.ironton.com/
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Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAY A (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration

Figure 1 below illustrates the test configuration used. It shows a simulated enterprise site connected
to Ironton’s network through the public internet.

For confidentiality and privacy purposes, actual public IP addresses and PSTN routable phone
numbers (DIDs) used during the compliance testing have been replaced with fictitious IP addresses
and PSTN non-routable phone numbers throughout the Application Notes.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500v2.
e Avaya IP Office Application Server running Avaya Voicemail Pro, Avaya one-X® Portal for

IP Office and Avaya WebRTC Gateway.

Avaya Session Border Controller for Enterprise.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 11x0 Series SIP IP Deskphones.

Avaya Communicator for Windows.

Avaya Equinox for Windows.

Avaya Communicator for Web.

Avaya 1408 and 9508 Digital Deskphones.

Located at the edge of the enterprise is the Avaya SBCE. The Avaya SBCE has two physical
interfaces, interface B1 is used to connect to the public network, interface Al is used to connect to
the private network. All SIP and RTP traffic entering or leaving the enterprise flows through the
Avaya SBCE. The Avaya SBCE provides network address translation at both the IP and SIP layers.

Also located at the enterprise site is Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP codec’s.
The IP Office LANL interface connects to the inside (Al) interface of the Avaya SBCE across the
enterprise LAN (private) network. The outside interface of the Avaya SBCE (B1) connects to
Ironton’s network via the public Internet.

The transport protocol between the Avaya SBCE and Ironton, across the public Internet, is SIP over
UDP. The transport protocol between the Avaya SBCE and IP Office, across the enterprise private
IP network, is SIP over TLS.

For inbound calls, the calls flowed from Ironton to the Avaya SBCE, then to IP Office.

Outbound calls to the PSTN were first processed by IP Office. Once IP Office selected the proper
SIP trunk, the call was routed to the Avaya SBCE for egress to Ironton’s network.
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For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls across
the SIP trunk to Ironton’s network (refer to Section 5.7). The short code 9 was stripped off by IP
Office but the remaining N digits were sent unaltered to the network.

In an actual customer configuration, the enterprise site may include additional network components
between the service provider and the Avaya IP Office system, such as a session border controller or
data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that all SIP and RTP traffic between the
service provider and the Avaya IP Office system must be allowed to pass through these devices.

~

~
Service Provider

Pilot Number: 1610-794-1234
Password: password123
FQDN: sip.test.com

-

>
Remote Workers

Avaya Communicator for
Windows (SIP))
R ——.
TLS, SRTP

SIP (UDP/RTP)

I

! Simulated Enterprise h
| Domain: avaya.lab.com
|

|

DIDs: 1610-794-2345, 6789

| B1: 10.10.80.51
= Avaya

T Session Border Controller
for Enterprise

A1:10.64.101.243

192.168.128.167

Avaya IP Office 500v2. Rel 11.0

Avaya IPO Office
Application Sever: Avaya 96x1 Serie:
- Avaya One-X Portal IP Deskphones

- Avaya Voicemail Pro (H.323)
- Avaya WebRTC gateway - Avaya IP Office Manager
- Avaya Communicator for
Windows Avaya 1100 Series IP
- Avaya Equinox for Deskliphones (SIP)
Windows
Analog Avaya 9508, 1408 - Avaya Communicator for

Deskphones  p;oital Deskphones Web

Figure 1: Avaya Interoperability Test Lab Configuration.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration.

Equipment/Software | Release/Version
Avaya

Avaya IP Office 500v2 11.0.0.0 Build 849
Avaya IP Office DIG DCPx16 V2 11.0.0.0 Build 849
Avaya IP Office Manager 11.0.0.0 Build 849
Avaya IP Office Application Server 11.0.0.0 Build 849

= Voicemail Pro 11.0.0.0 build 481

=  Avaya WebRTC Gateway 11.0.0.0 build 849

= Avaya one-X® Portal for IP Office 11.0.0.0 build 457
Avaya Session Border Controller for Enterprise 7.2.2.0-11-15522
(running on Portwell CAD-0208 platform)
Avaya 96x1 Series IP Deskphones (H.323) Version 6.6604
Avaya 1140E IP Deskphones (SIP) SIP1140e Ver. 04.04.23.00
Avaya Communicator for Windows 2.1.4.0
Avaya Equinox™ for Windows 3.4.5.10.3
Avaya Communicator for Web 1.0.16.2220
Avaya Digital Deskphones 1408 R48
Avaya Digital Deskphones 9508 R60
Lucent Analog Phone --

Ironton

PortaOne Soft Switch MR55
Genband S3 9.3.1

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500v2 also when deployed with all configurations of IP Office Server Edition.
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5. Configure IP Office

This section describes the IP Office configuration required to interwork with Ironton. IP Office is
configured through Avaya IP Office Manager (IP Office Manager) which is a PC application. On the
PC, select Start - Programs > IP Office = Manager to launch IP Office Manager. A screen that
includes the following may be displayed.

WELCOME to IP Office Administration

What would you like to do?

Create an Offline Configuration

| Open Configuration from System|

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File = Open Configuration at the top of the Avaya
IP Office Manager window. Select the proper IP Office from the pop-up window, and log in with the
appropriate credentials.

The appearance of the Avaya IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane on
the left side, omit the Group pane in the center, and show the Details pane on the right side. Since
the Group pane has been omitted, its content is shown as submenus in the Navigation pane. These
panes (Navigation and Details) will be referenced throughout the IP Office configuration. All
licensing and feature configuration that is not directly related to the interface with the service
provider is assumed to already be in place.

In the sample configuration, the MAC address 00E00706530F was used as the system name. All
navigation described in the following sections (e.g., License = SIP Trunk Channels) appears as
submenus underneath the system name 00E00706530F in the Navigation Pane.
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5.1 Licensing

The configuration and features described in these Application Notes require the IP Office system to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact
an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity, click License in the
Navigation pane and examine SIP Trunk Channels in the Detail pane. Confirm that there is a valid
license with sufficient “Instances” (SIP Trunk Channels) in the Details pane.

| IP Offices |
8 BOOTP (6) License | Remote Server
F#-¢# Operator (3
=B =| 00ED0706530F License Mode License Normal

E‘".L?f--frftnegrgggggﬁﬂgF Licensed Version 11.0

-7 Line (5) PLDS Host ID

(-2 Control Unit (4) ) )

-4 Extension (37) PLDS File Status ~ Valid

BB User (32)

Egﬁ Ef:otltpctl?j ©7) Feature Key Instances Status
ort Code
@ Service (0) Mobile Worker MN/A 384 Valid

oy RAS (1) Office Worker MN/A 384 Valid

EJ-"@ Incoming Call Route (4) Avaya Softphone Licence MN/A 100 Valid
-4 ‘5‘_’““ Port (0) VMPra TTS (Scansoft) 7 40 Valid
o TiI:S;ng?Q - VMPro TTS Professional N/A 40 Valid

EJ---@ Firewall Profile (1) IPSec Tunnelling MN/A 1 Valid

[+l IP Route (4) Power User N/A 384 Valid
- Account Code (0) Awaya IP endpoints MN/A 384 Valid
~Realicense (102) IP500 Voice Networking Channels  N/A 22 Valid
¥ Tunnel (©) SIP Trunk Channels | /A |128 | Valid

-§5 User Rights (8)

Gl g ARS (1) IP500 Universal PRI (Additional cha... N/A 100 Valid
-8 Location (0) CTI Link Pro MN/A 1 Valid
m Authonzation Code (0) Wave User MAA 16 Valid

3rd Party IP Endpoints N/A 384 Valid

5.2 System

Configure the necessary system settings. In an Avaya IP Office, the LANZ tab settings correspond to
the Avaya IP Office WAN port (public network side) and the LAN1 tab settings correspond to the
LAN port (private network side). For the compliance test, the LANL1 interface was used to connect
IP Office to the enterprise private network (LAN), LAN2 was not used.

5.2.1 System - LAN1 Tab

In the sample configuration, the MAC address 00E00706530F was used as the system name and the
LAN port connects to the inside interface of the Avaya SBCE across the enterprise LAN (private)
network. The outside interface of the Avaya SBCE connects to Ironton’s network via the public
internet. The LAN1 settings correspond to the LAN port in IP Office. To access the LANL1 settings,
navigate to System (1) = 00E00706530F in the Navigation Pane, then in the Details Pane navigate
to the LAN1-> LAN Settings tab. The LANL1 settings for the compliance testing were configured
with following parameters:

e Set the IP Address field to the LAN IP address, e.g., 192.168.128.167.
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e Setthe IP Mask field to the subnet mask of the enterprise private network, e.g.,

255.255.255.0.

e All other parameters should be set according to customer requirements.
e Click OK to commit (not shown).

IP Offices

i
o

00E00706530F

=& BOOTP (6)
1,_&- Operator (3)
=-+={ 00EDD706530F
E|5 System (1)

|5 ODEDD706530F
-F1 Line (5)
-2 Control Unit (4)
-4 Extension (37)
£
[
[

@ User (32)

-5 Group (1)

r-@% Short Code (67)

----- B Service (0)

oy RAS (1)

Ej---@ Incoming Call Route (4)
----- $8 WAN Port (0)

----- = Directory (0)

----- £71 Time Profile (0)

- Firewall Profile (1)
c-Jill IP Route (4)

----- 8 Account Code (0)

----- % License (102)

----- & Tunnel (0

[]---E-‘. User Rights (8]

- ARS (1)

----- i@ Location (0)

----- ﬂ Authorization Code (0)

| System ||-AN1 LANZ | DNS | Voicemnail | Telephony | Directory Services | Systemn Events |

LAM Settings |‘ufoIP | Metwork Topology|

1P Address 192 . 168 . 128 . 167

IP Mask 255 . 255 . 255 . 0

Primary Trans. IP Address o .0 . 0 .0

RIP Mode [None -
] Enable MAT

Y

MNumber Of DHCP IP Addresses (200
DHCP Mode

© Server © Client © Dialln @ Disabled
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The VoIP tab as shown in the screenshot below was configured with following settings:

e Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the
H.323 protocol to register.

e Select Preferred under H.323 Signaling over TLS. When enabled, TLS is used to secure
the registration and call signaling communication between IP Office and endpoints that
support TLS. The H.323 phones that support TLS are 9608, 9611, 9621, and 9641 running
firmware version 6.6 or higher.

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to
Ironton.

e Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register using
the SIP protocol.

e Enter the Domain Name of the enterprise under SIP Domain Name.

e Enter the SIP Registrar FQDN of the enterprise under SIP Registrar FQDN.

e Check TLS and verify the TLS Port numbers under Layer 4 Protocol is set to 5061.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

e Inthe Keepalives section at the bottom of the page, set the Scope field to RTP-RTCP,
Periodic Timeout to 30, and Initial keepalives to Enabled. This will cause the IP Office to
send RTP and RTCP keepalive packets at the beginning of the calls and every 30 seconds
thereafter if no other RTP/RTCP traffic is present.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

IP Offices IE 0DEQ0706530F
“ gopg:;(r%) | System [LANL |LaN2 [DNS [ Voicemail | Telephony | Directory Services | System Events | sMTP [SMDR [ VM [VolP | VolP Security
<2 [D0EDOT06530F | LAN Settings [ VoIP { Network Topology |
EH= System (1)
2 ODEDOT06530F
T‘- E;‘:t(i)l ot 1 [] Auto-creste Extension Auto-creste User H.323 Remote Extension Enable
f ﬁ:r"é';)" G7) [H323 Signaling over TLs ~ Preferred | +  Remote Call Signaling Part 1720
$ g;z:ré?demn SIP Trunks Enable
g ;::;I(T]m) SIP Registrar Enable
P Incoming Call Route (4) [[] Auto-create Extension/User SIP Remote Extension Enable
¥ WAN Port (0)
- Directory (0) SIP Domain Name avaya.lsb.com
£ ) Time Profile (0)
@ Firewall Profile {1} SIP Registrar FQDN avaya.lab.com
EA 1P Route (4)
-4 Account Code (0) uDP UDP Port 5060 Remote UDP Port 5060
- License (102)
@ Tunnel (0) Layer 4 Protocol [¥] Tce TCP Port (5060 Remote TCP Port 5060
ﬁ,' };‘Ri'gi]gh“m TS TiSPort [5061 Remote TLS Port 5061
] g ‘I;?Jct:‘ttw;:a(g]m Code (0) Challenge Expiration Time (sec) 10
RTP
Port Mumber Range
Minimum 49152 Mazximum 53246
Port Mumnber Range (NAT)
Minimum 49152 Maximum 53246
Enable RTCP Monitoring on Port 5005
RTCP collector IP address for phones 0 0 0 0
Keepalives
Scope Periodic timeout 30
Initial keepalives
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Note: In the compliance test, the LAN1 interface was used to connect IP Office to the enterprise

private network (LAN), LANZ2 was not used.

5.2.2 System - Telephony Tab

Navigate to the Telephony - Telephony tab in the Details Pane, configure the following
parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used.
e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfers to the PSTN via the SIP trunk to the service provider.
e All other parameters should be set according to customer requirements.
e Click OK to commit (not shown).
IP Offices |E 00E00706530F
=R ggg:l%] system | LANL | LANZ | DNS | Voicemail |} Telephony if Directory Services | System Events | sMTP | SMDR | vem | volp | voIP Security
<[0DEQ0706530F Telephony | park & Page | Tones & Music| Ring Tones [ sM | CallLog | TUI |
S5 Systern (1)
L4y ODEDOTO6530F Analogue Bxtensions

-

-

T4 Line (5)
-“<r Control Unit (4)
-4 Extension (37)

§ User(32)

i Group (1)

@ Short Code (67)
@ Service (0)

ol RAS (1)

@ Incoming Call Route (4)

- B8 WAN Port (0)
-8 Directory (0)
£ Time Profile (0)
-} Firewall Profile (1)

Bl 1P Route (4)

-l Account Code (0)
- B License (102)
-l Tunnel (0)

-fis User Rights (8)

¢ ARS (1)

-5 Location (0)
m Authorization Code (0)

Default Outside Call Sequence
Default Inside Call Sequence

Default Ring Back Sequence

Restrict Analogue Extension Ringer Voltage

Dial Delay Time (sec) 3
Dial Delay Count 0

Default No Answer Time (sec) 20

Hold Timeout (sec) 0
Park Timeout (sec) 300
Ring Delay (sec) 5

Call Priority Promotion Time (sec) |Disabled

[Normal v]
[Ring Typel V]
[Ring Type 2 ']
o

Line

@ U-Law Line

) A-Law Line

AP\ ([Pl ([l (FTeIf (D) (o]

Dial By Mame

Show Account Code

ID Inhibit Off-Switch Forward,/Transfer

[] Restrict Metwork Interconnect

Include location specific information
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5.2.3 System — VoIP tab

For Codec settings, navigate to the System (1) - 00E00706530F in the Navigation Pane, select the
VoIP tab and configure the following parameters:

e Select or enter 101 for RFC2833 Default Payload. This setting was recommended by
Ironton for use with out-of-band DTMF tone transmissions.

e For codec selection, select the codecs and codec order of preference on the right, under the
Selected column. The Default Codec Selection area enables the codec preference order to be
configured on a system-wide basis. The buttons between the two lists can be used to move
codecs between the Unused and Selected lists, and to change the order of the codecs in the
Selected codecs list. By default, all IP phones (SIP and H.323) will use the system default
codec selection shown here, unless configured otherwise for a specific extension. The
example below shows the codecs used for IP phones (SIP and H.323). The system’s default
codecs and order was used.

IP Offices | i= 00E00706530F
@-R BOOTP (6) | System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | sMTP [ sMDR [vem | VolP "1
- Operator (3)
[=-+#%7| 00EDOT0B530F Ignore DTMF Mismatch For Phones 0
EH=P System (L) . I .
i...#%5 OED0706530F Allow Direct Media Within NAT Location |

t-F4 Line (5)
1< Control Unit (4) |RFC2833 Default Payload 101 |
H-48 Extension (37)
Ja User (32) Available Codecs Default Codec Selection

Jﬂ Group (1) Unused Selected

8% Short Code (67) G.711 ULAW 64K G722 64K N G711 ULAW 64K

;:g ;:’;'ae] o G711 ALAW 64K G711 ALAW 64K

- Incoming Call Route () G.T2264K G.729() 8K CS-ACELP
G.729(a) 8K CS-ACELP 67231 6K3 MP-MLQ

----- 8 WAN Port (0) : !
_____ = Directory (0) 67231 6K3 MP-MLQ oy

£ Time Profile (0)
-8 Firewall Profile (1)
--Jill 1P Route (4)

----- 8 Account Code (0) —
----- % License (102)

----- @& Tunnel (0)

i-f5 User Rights (8)

- ARS (1)

----- &5 Location (0)

----- 28 Authorization Cade (0)

Afr

o O O O e W e O

-

Note: The codec selections defined under this section (System — VoIP Tab) are the codecs selected
for the IP phones/extensions. The codec selections defined under Section 5.4.4 (SIP Line — VVolP
tab) are the codecs selected for the SIP Line (Trunk).
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5.2.4 System — VoIP Security Tab
Secure Real-Time Transport Protocol (SRTP) refers to the application of additional encryption and

or authentication to VolP calls (SIP and H.323). SRTP can be applied between telephones, between
ends of an IP trunk or in various other combinations.

Configuring the use of SRTP at the system level is done on the System VolP Security tab using the
Media Security setting. The options are:

e Disabled (default).

e Preferred.

e Enforced.

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP
Office uses SRTP if supported by the far-end, otherwise uses RTP. If the Enforced setting is used,
and SRTP is not supported by the far-end, the call is not established.

To configure the use of SRTP, navigate to the System (1) = 00E00706530F in the Navigation Pane,
select the VoIP Security tab and configure the following parameters:

e Under Media select Preferred from the pull-down menu.

e Verify that Strict SIPS is not checked.

e Under Media Security Options ensure that RTP is checked under Encryptions and

Authentication.
e Under Crypto Suites ensure that SRTP_AES_CM_128 SHAL 80 is checked.
e Click OK to commit (not shown).

IP Offices | = 00E00706530F
=& B0OTP (§) System | LAN1 [LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | sMTP | SMDR [ vem [ volp | VolP Security
[#-¢% Operator (3)

- EJ P:JEUS[;?S[t]::ng?lF] Media [Preferred v] [T Strict SIPS
-7 00E0706530F
5-T7 Line (3]
H-“=r Control Unit (4)
-4 Extension (37) Media Security Options
3 a User (32) Encryptions RTP
J--@ Group (1)
58X Short Code (57) [ rTCP
- Service (0) Authentication RTP
ol RAS (1)
]--@ Incoming Call Route (4) RTCP
. @ WAN Port (0) Replay Protection
3 : Directory (0) SRTP Window Size 64
j@ 'II:'.rme P”rT:”iEm Crypto Suites
-5 Ir,";‘;"zte (:f') ile (1) SRTP_AES_CM_128_SHA1 80
& Account Code (0) [] SRTP_AES CM 128 SHA1 32

Ry License (102)

i Tunnel (0)

H-fig User Rights ()

H-" ARS (1)

[ | ocation (0)

= ﬂ Authorization Code (0)
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5.3 IP Route

Create an IP route to specify the IP address of the gateway or router where IP Office needs to send
the packets in order to route calls to Ironton’s network (if located in a different IP subnet).

In the reference configuration, the IP Office LANL1 interface and the private interface of Avaya
SBCE resided in different IP subnets, so an IP route was necessary to specify the IP address of the
gateway or router where IP Office needs to send the packets, in order to reach the IP subnet of the
private interface of Avaya SBCE.

To create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to reach the IP subnet where the Avaya SBCE resides (if located in
different IP subnets), on the left navigation pane, right-click on IP Route and select New.

e Setthe IP Address and IP Mask of the IP subnet of the private side of the Avaya SBCE, or

enter 0.0.0.0 to make this the default route.

e Set Gateway IP Address to the IP Address of the default router in the IP Office IP subnet.

e Set Destination to LAN1 from the pull-down menu.

e Click OK to commit (not shown).

IP Offices = 0.0.0.0

=- R BOQTP (6) IP Route

‘.j-f Cperator (3)

= <[ DOE00706530F IP Address 0 0 0 0
- System (1)
b5 (OEDDT06530F IP Mask 0 0 0 0

-7 Line (5) Gateway IP Address 192 . 168 . 128 . 200
H-<2» Control Unit (4}

e
E

-8 Extension (37) Destination |LANL
B-§  User(22)

E
E

058 Group (1) Metric 0
H--@% Short Code (67)
_____ B Senvice 0) [C] Proxy ARP
ol RAS (1)

- Incoming Call Route (4)
----- E8 WAN Port (0)

----- @u Directory (0)

€17 Time Profile (0)

G- Firewall Profile (1)

= P Route (4)

192.168.99.0

il 200.76.179.0

[l 216.68.145.0

----- @8 Account Code (0}

----- % License (102)

""" % Tunnel [0)

&-fig User Rights (8)

B ARS (1)

----- & Location (0)

----- @ Authorization Code (0)
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5.4 SIP Line

DevConnect generated SIP Line templates are always exported in an XML format. These XML
templates do not include sensitive customer specific information and are therefore suitable for
distribution. The XML format templates can be used to create SIP trunks on both IP Office Standard
Edition (500 V2) and IP Office Server Edition systems. Alternatively, binary templates may be
generated. However, binary templates include all the configuration parameters of the Trunk,
including sensitive customer specific information. Therefore, binary templates should only be used
for cloning trunks within a specific customer’s environment.

Copy a previously created template file to a location (e.g., \temp) on the same computer where IP
Office Manager is installed.

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then navigate
to New - New from Template->Open from file.

=& BOOTP (6) SIP Line | Transport| Call Details |VolP [ T38 Fax|SIP Credg

4% Operator (3)

-2 00E00706530F Line Nurnber 17 z
I voip.centurylin
=R L
: T= _ & Cut Ctrl+X

53 Copy Ctrl+C
_ SIP URI
, Paste Ctrl+V
| 7¢ Delete Ctrl+Del Cloud
Co ./ Validate

Connect To... Ctrl+T

Mew from Template Open from file

- - -
-3 el

5h Export as Template
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Navigate to the directory on the local machine where the template was copied and select the
template.

'] Open =
@uv| 0 v Computer » TOSHIBA (F:) » Ironton » App MNotes » Template - |¢’. | | Search Template P |
Organize = New folder i« 0 .@.

=
¢ Favorites MName Date modified Type Size
Bl Desktop 2] IronIPO11SBCT2.xml 9/27/2018 9:32 AM XML Document 4 KB |
& Downloads

5] Recent Places
1% Computer

B, Avaya eSOE (C)

- TOSHIBA (E)

o TOSHIBA (F)

File name: - [Template Files (*xml) V]

[ open | [ cancel |

After the import is complete, a final import status pop-up window will open stating success or
failure. Click OK

I "

Ternplate Provisicning @

I:o:l Mew SIP Trunk created successfully using selected template.

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

=& BOOTP (5)

“f:' Operator (3

IEI".L?"J S}rsteﬂ"l |:1:|

459 DE00706530F
= (s

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.4.1 to 5.4.6.
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5.4.1 SIP Line - SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

Leave the ITSP Domain Name blank. Note that if this field is left blank, then IP Office
inserts the ITSP Proxy Address from the Transport tab as the ITSP Domain in the SIP
messaging.

Verify that URI Type is set to SIP URI.

Verify that In Service box is checked, which is the default value. This makes the trunk
available to incoming and outgoing calls.

Verify that Check OOS box is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line.

Verify that Refresh Method is set to Auto.

Verify that Timer (seconds) is set to On Demand.

Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing
Supervised REFER to Always.

All other parameters should be set to default or according to customer requirements.
Click OK to commit (not shown).

IP Offices = SIP Line - Line 17
SIP LiﬂelTransporthaII D'etailsl‘u’oIP |T38 FaxlSIP Credentials | SIP AdvancedlEngineering|
Line Number 17 s In Service
|1'rsp Domain Name | Check 00S
Local Domain Name
|URI Type ’SIP URI | .] Session Timers
Location ’CIoud v] Refresh Method Auto
&2 Control Unit (4) Timer (sec) On Demand
-4 Extension (37)
E-§ User (32) _
=-5§ Group (1) Prefix
- 8% Short Code (67) . .
_____ 9 Service (0) Mational Prefix 1
-l RAS (1) . )
Int: ti | Prefi
@ Incoming Call Route (4) || oo e
..... @ WAN Port (0) Country Code Redirect and Transfer
----- a5 Directory (0) n R
f.i*) Time Profile (0) Name Priarity System Default = Incoming Supervised REFER ’Always
@@ Firewall Profile (1) - Outgoing Supervised REFER ’Always
&-[ll IP Route (4) Description
..... & Account Code (0) Send 302 Moved Temporarily [}
----- % License (102) . )
_____ ¥ Tunnel (0) Outgoing Blind REFER [}
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5.4.2 SIP Line - Transport Tab

Select the Transport tab; configure the parameters as shown below:

e Setthe ITSP Proxy Address to the inside IP Address of the Avaya SBCE or 10.64.101.243

as shown in Figure 1.
e Set the Layer 4 Protocol to TLS.

e Set Use Network Topology Info to None (see note below).

e Set the Send Port to 5061.

e Default values may be used for all other parameters.
e Click OK to commit (not shown).

IP Offices T

SIP Line - Line 17*

=- % BOOTP (6)

|SIP Line| Transport |Call Details|VolP | T38 Fax|SIP Credentials| SIP Advanced |Engineering|

¢ Operator (3]
== D0E0ODT06530F

: | ITSP Proxy Address  10.64.101.243 |
=520 System (1)

[ Control Unit (4)
(-4 Extension (37) Calls Route via Registrar
B-§ User (32)
B
B

]ﬂ Group (1)
@ Short Code (67)

,,,,, @B Service (0) Separate Registrar

. 5 Q0EQ0706530F —

P Metwork Configuration

=1 {Tine 5) J
o a1 Layer 4 Protocol ITLS vl Send Port 5061
g 2
..... Use Metwork Topology Info ’None vl Listen Port 2061
by, 18
-y 19 Explicit DNS Server(s) 0 0 0 0 0 0 0

Note — For the compliance testing, the Use Network Topology Info field was set to None, since no
NAT was used in the test configuration. In addition, it was not necessary to configure the System 2>
LAN1 - Network Topology tab for the purposes of SIP trunking. If a NAT is used between Avaya
IP Office and the other end of the trunk, then the Use Network Topology Info field should be set to
the LAN interface (LAN1) used by the trunk and the System = LAN1 -> Network Topology tab

needs to be configured with the details of the NAT device.
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5.4.3 Call Details Tab

A SIP URI entry needs to be created to match each incoming number that IP Office will accept on
this line. Select the Call Details tab, and then click the Add... button and the screen shown below
will appear. To edit an existing entry, click an entry in the list at the top, and click the Edit... button.
In the example screen below a new entry was added. For the compliance test, a single SIP URI entry
was created that matched any DID number assigned to an IP Office user. The entry was created with
the parameters shown below:

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. The outgoing line group number is used in defining short codes for routing
outbound traffic to this line. For the compliance test, a new incoming and outgoing group 17
was defined that only contains this line (line 17).

e Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP
URI pattern.

e Set the Credentials field to 0:<None>

e Set the Local URI, Contact, P Asserted ID and Diversion Header fields to the values
shown in the screenshot below.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

e Click OK to commit again (not shown).

' SIP Line - 17 | Call Details | SIP URT =s
New URI
Incoming Group 17 w»  Max Sessionz o :
Outgoing Group 17 -
Credentials 0: <None> A
Display Content Field meaning
Outgoing Calls Forwarding/ Twinning Incoming Calls
Local LRI Use Intemal Data » Uselntemal Data  « [Caller ,] [Original Caller v] [Called ,]
Cortact Uze Intemal Data » Uselntemal Data w [Caller ,] [Caller v] [Called ,]
P Asserted ID Use Intemal Data v Ussintemal Data  ~ |pone +] [Caler +| [None -]
PPrefered ID [C] |Nome Nene None None None
Diversion Header Use Intemal Data » Uselntemal Data [None ,] [Caller ,] [None .]
Remote Party ID  [C] |None None None Mone None
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5.4.4 SIP Line - VoIP Tab

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

In the sample configuration, the Codec Selection was configured using the Custom option,
allowing an explicit order of codecs to be specified for the SIP Line. The buttons allow
setting the specific order of preference for the codecs to be used on the SIP Line. As shown,
the codec order of G.711 ULAW and G.729(a) were selected for audio.

Set Fax Transport Support to T.38.

Set the DTMF Support field to RFC2833. This directs IP Office to send DTMF tones using
RTP events messages as defined in RFC2833.

Set the Media Security field to Same as System (Preferred).

Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on the
trunk.

Check the PRACK/100rel Supported box.

Default values may be used for all other parameters.

Click OK to commit (not shown).

IP Offices |E SIP Line - Line 17

O-E-F

-R BOOTP (6)

t--<== Control Unit (4)
t)--4 Extension (37)
H-§  User 32)

J"ﬂ Group (1)

|SIP LinelTranspor‘thaII Detai\sl\"olp |T38 Fa)(lSIP CredentialslSIP AdvancedlEngineermg|

[T] VelP Silence Suppression

[ Local Hold Music

Re-invite Supported

[] Codec Lockdown

kodec Selection [CUStOI"ﬂl v]

Selected

G711 ULAW 64K
G.729(a) 8K C5-ACELP

Unused

G.711 ALAW 64K
G.722 64K

G.7231 6K3 MP-MLQ

[] Allow Direct Media Path

" 19

Force direct media with phones

| & prACK/100re! Supported

5,711 Fax ECAN

/8% Short Code (67)
@ Service (0)
1l RAS (1)

- BE) WAN Port (0)

s Directory (0]
-7 Time Profile (0)
-8} Firewall Profile (1)
ol IP Route (4)

-l Account Code (0)
- License (102)
- Tunnel (0)

H-fia User Rights (8)

H- g ARS (1)

&g Location (0)

J--@ Incoming Call Route (4)

m Authorization Code (0)

Fax Transport Support [TBS

DTMF Support [RFc2833

Media Security [Sameas System (Preferred)

Advanced Media Security Options

Same As System

RTP

RTCP

RTP

RTCP

64

Note: The codec selections defined under this section (SIP Line — VVolIP tab) are the codecs selected
for the SIP Line (Trunk). The codec selections defined under Section 5.2.3 (System — VoIP tab) are
the codecs selected for the IP phones/extension (H.323 and SIP).
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5.4.5 SIP Line — T38 Fax Tab

Select the T38 Fax tab, to set the Fax over Internet Protocol parameters of the SIP Line. Set or
verify the parameters as shown below:

e Uncheck the Use Default VValues at the bottom of the screen.
e Set the T.38 Fax Version to 0, Ironton supports T.38 fax version 0.
e Default values may be used for all other parameters.
IP Offices = SIP Line - Line 17°
a BOOTP (6) |SIP LinelTransporthaII DetailslVoIP |-|-38 Fax |SIP CredentialslSIP AdvancedlEngineering

1 Operator (3)

D0ED0706530F
= System (1)

T38 Fax Version

[

°]

Scan Line Fix-up

=" Transport UDPTL
; P TFOP Enhancement
; Redundanc
Y [C] Disable T30 ECM
Low Speed =
g [7] Disable EFlags For First DIS
High Speed z [7] Disable T30 MR Compression

-2 Control Unit (4)
[-48 Extension (37) TCF Method ’Trans TCF vl ] MSF Override
E-§  User (32)
-89 Group (1) Max Bit Rate (bps) (14400 - 5
E-8% Short Code (57) —

..... @ Service (0] EFlag Start Timer (ms) 2600 = 0
E-alf; RAS (1) . 2300 =
-4 Incoming Call Route (4) EFlag Stop Timer (ms) =

""" Ej’ WAN Port (0) Tx Network Timeout (sec) (130 =

----- a5 Directory (0)

----- {1 Time Praofile (0)
- @ Firewall Profile (1) [ Use Default Values
&-Jiilll IP Route (4)
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5.4.6 SIP Line — SIP Advanced Tab

Select the SIP Advanced tab.
e Verify that Call Routing Method is set to Request URI.
e Check the box for Use PAI for Privacy.
e Check the box for Emulate NOTIFY for REFER (Section 2.2).
e Default values may be used for all other parameters.
e Click OK to commit (not shown).

IP Offices |E SIP Line - Line 17 =
a BOOTP (6) |SIP LinelTransporthaII Detai\slVoIP |T38 Fa)(lSIP Credentialsl SIP Advanced |Engmeering|
Fl-4# Operator (3)
=] : 00E00706530F Addressing Media
g Association Method [By Source IP address ‘] Allow Empty INVITE 0
p— py— [R Uml ] Send Empty re-INVITE 0
| éll Routing Metho equest s Allow To Tag Change 0
Suppress DNS SRV Lookups ] P-Early-Media Support None
] Send SilenceSupp=0ff ]
H-<2» Control Unit (4) Identity
t-4 Extension (37) " "
o User 32) Use "phone-context 0 Media Connection :ni;abled
3“ Group (1) Add user=phone 0 Preservation
+-@% Short Code (67) Use + for International 0 Indicate HOLD [
@ Service (0) I Use PAI for Privacy I
H-alfy RAS (1) -
-4 Incoming Call Route (4) Use Domain for PAL O Call Control
--Eg WAN Port Caller ID fi Fi head ~
EE Direct ort () alerirom From header 0 Call Initiation Timeout (s) 4 =
£y T\re ;lfyff?) Send From In Clear 0
jé FiI:S:ral:,T’rlniiE:)(l) Cache Auth Credentials Call Queuing Timeout (mins) 3 =

=-Jill IP Route (4) User-Agent and Server Headers Service Busy Response 486 - Busy Here

-l Account Code (0)

@ License (102) Send Location Info [Never - on Mo User Responding Send | 408-Request Timeout
il Tunnel (0)
0§ User Rights (8) Add UUT header o Action on CAC Location Limit | Allow Voicemnail
£ ARS (1) Adl;i UUT header to redirected Suppress Q850 Reason
4@ Location (0) cals Header I 0
8 Authorization Code (0 Emulate NOTIFY for REFER__ (V]|
Mo REFER if using Diversion I
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5.5 Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line
defined in Section 5.4. To configure these settings, first navigate to User > Name in the Navigation
Pane where Name is the name of the user to be modified. In the example below, the name of the user
is Ext3040 H323. Select the SIP tab in the Details Pane. The values entered for the SIP Name allow
matching of the SIP URI for incoming calls without having to enter this number as an explicit SIP
URI for the SIP Line (Section 5.4.3). The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise by Ironton, note that the “1” was included. The SIP Display Name (Alias)
parameter can optionally be configured with a descriptive name. If all calls involving this user and a
SIP Line should be considered private, then the Anonymous box may be checked to withhold the
user’s information from the network. This can also be accomplished by activating Withhold Number
on H.323 Deskphones (not shown). Click the OK to commit (not shown).

IP Offices |Ei Ext3040 H323: 3040°
a BQOTP (6) I | Voice Recording | Button Programming | Menu Programming | Mability | Group Membership | Announcementsl SIP [
= D0E00706530F SIP Name 16107942345
H-%57 Systemn (1)
& Line (5) SIP Display Name (Alias) Ext3040 H323
= Control Unit (4)
-4 Extension (37) Contact 16107942345

-

: RemoteManager
; Maolser [C] Anonymous
§~ 3055 3055

§ [ 3040 Ext3040 H323

. - 3001 BB0AL 32
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5.6 Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system. In a scenario like the one used for the
compliance test, only one incoming route is needed, which allows any incoming number arriving on
the SIP trunk to reach any predefined extension in IP Office. The routing decision for the call is
based on the parameters previously configured for Call Routing Method (Section 5.4.6) and SIP
URI (Section 5.4.3) and the users SIP Name and Contact, already populated with the assigned
Ironton DID numbers (Section 5.5).

5.6.1 Incoming Call Route — Standard Tab

To create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and
select New.

On the Standard tab of the Details Pane, enter the parameters as shown below.
e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
e Default values can be used for all other fields.

IP Offices = 17
a‘ BOOTP (6) Standard | Vioice Recording | Datinations|
H-4% Operator (3]
== [00EDOT0G530F
-5 System (1) Bearer Capabili Any Voice -
H-14 Line (3) pability l A
-2 Control Unit (4) Line Group ID 17 -
(-4 Extension (37)
H-§  User(32) Incoming Mumber
u Group (1)
8% Short Code (67) Incoming Sub Address
@ Service (0) .
o RAS (1) Incoming CLI
EI@ Inc%ming Call Route E4]| Locale ’ v]
@ 18 Priority ll - Low v]
Tag
----- EEWAN Port (0)
..... @ Directory (0) Hold Music Source ’System Source v]
----- £19 Time Profile (0) _ _ N
-} Firewall Profile (1) Ring Tone Override one -
&-Jll 1P Route [4)
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5.6.2 Incoming Call Route — Destinations Tab

e Under the Destinations tab, enter “.” for the Default Value. This setting will allow the call
to be routed to any destination with a value on its SIP Name field, entered on the SIP tab of
that User, which matches the number present on the user part of the incoming Request URI.

e Click OK to commit (not shown).

IP Offices |Ei 17~
"'x BOOTP () | Standard | Voice Recordingl Destinations
“ Operator (3
= ED0706530F TimeProfile Destination Fallback Extension
W System (1) 4 |De‘Fau\tVa|ue [ | |v ‘[
017 Line (5)

tl-<2» Control Unit (4)
+|- 4 Extension (37)
i@ User (32)

J--a Group (1)
£|-@X% Short Code (67)
- B Service (0)

-l RAS
D0
18
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5.7 Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing can
be specified so that a call can re-route automatically if the primary route or outgoing line group is
not available. While detailed coverage of ARS is beyond the scope of these Application Notes, and
alternate routing was not used in the reference configuration, this section includes some basic screen
illustrations of the ARS settings used during the compliance testing.

5.7.1 Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation Pane and
select New. The screen below shows the short code 9N created (note that the semi-colon is not used
here). In this case, when the IP Office user dials 9 plus any number N, instead of being directed to a
specific Line Group ID, the call is directed to Line Group 50: Main, which is configurable via
ARS.
e Inthe Code field, enter the dial string which will trigger this short code. In this case, 9N was
used (note that the semi-colon is not used here).
e Set Feature to Dial. This is the action that the short code will perform.
e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.
e Setthe Line Group ID to 50: Main to be directed to Line Group 50: Main, which is
configurable via ARS.
e Click the OK to commit (not shown).

IP Offices =Y 9N: Dial*
----- I 337N ~ || Short Code
..... “ *34[.'].:
..... “ *BS*N# ':Elle QN
..... “ *36
----- B 37 NE Feature |Dia|
----- R 3ENE
..... B *39 Telephone Mumber M
----- % =40 .
ol
..... “ =41 Line GF'I"-'F] o m
""" B 42 Locale |
..... “ =43
----- =44 Force Account Code
'''' B 457N Force Authorization Code | |
..... “ *45 Horr
..... ; : k
[oxcon
----- 8% FMEDD =
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The following screen shows a sample ARS configuration for the route 50: Main. Note the sequence
of X’s used in the Code field of the entries to specify the exact number of digits to be expected,
following the access code and the first set of digits on the string. This type of setting results in a
much quicker response in the delivery of the call by IP Office.

To create a short code to be used for ARS, select ARS - 50: Main on the Navigation Pane and
click Add (not shown).

In the Code field, enter the dial string which will trigger this short code. In this case, 1
followed by 10 X’s to represent the exact number of digits.

Set Feature to Dial. This is the action that the short code will perform.

Set Telephone Number to 1N. The value N represents the additional number of digits dialed
by the user after dialing 1 (The 9 will be stripped off).

Set the Line Group ID to the Line Group number being used for the SIP Line, in this case
Line Group ID 17 was used.

Set the Locale to the specific country and language, in this case United States (US English).
Click OK to commit.

Edit Short Code

Code 100000000
Feature Dial -

Telephone Mumber 1N

Line Group ID 17 -

Locale | United States (US Engish)  +

Force Accourt Code O

Force Authorization Code [

Repeat the above procedure for additional dial patterns to be used by the enterprise to dial out from
IP Office.
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The highlighted entry below of 1 plus 10 digits (represented by 10 X’s) was used to make call within
the North American Numbering Plan (NANP).

The user dialed 9, followed by 1 and 10 digits (represented by 10 X’s). The 9 is stripped off, the
remaining digits, including the 1, are included in the SIP INVITE message IP Office sends to

Ironton.
IP Offices = Main g -H X
@& BOOTP (5) ARS
1 Operstor (3)
8 *‘J ARS Route ID 50 Secondary Dial tone
59 System (1)
f‘. Iég:t(rso)‘ Unit (4) Route Name Main [SystemTone
& Bxtension (37)
-§  User 32) Dial Delay Time System Default (3) = Check User Call Barring
-3 Group (1)
--@% Short Code (66) o
9 Service (0) escription
o RAS (1)
@ Incoming Call Route {4)
&5 WAN Port (0) In Service Out of Service Route [<none> -
- Directory (0)
£ Time Profile (0) 1
@ Firewall Profile (1) Time Profile <MNone> — (Out of Hours Route l<Nune> V]
[l IP Route (4)
-~ Account Code (0) l
% License (102)
: EUM;I (f‘i ) Code Telephone Number Feature Line Group ID .
3 SEr h 5
& JaRs ) [ 13000000000 N Dial 17
ﬁ[( 50 Main BX000K &N Dial 17 |E
&8 Location (0) OO0 3N Dial 17 y
% Authorization Code (0) 2BXO000KX 28N Dial 17
SEHOOOO00 55N Dial 17
OLOOCOOO000MKK. 01N Dial 17
04X 04N Disl 17 =
< mn 3
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5.8 Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

HG; Reviewed:
SPOC 10/29/2018

r

Save Configuration

IP Office Settings

ol ® )|

DOEOO706530F

Configuration Reboot Mode

@ Merge
Immediate
When Free
Timed

Reboot Time

13:19

Call Barring

OK

l | Cancel | |

Help
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the required configuration of the Avaya SBCE to connect to Ironton SIP
Trunking Service.

It is assumed that the Avaya SBCE was provisioned and is ready to be used; the configuration shown
here is accomplished using the Avaya SBCE web interface.

Note: In the following pages, and for brevity in these Application Notes, not every provisioning step
will have a screenshot associated with it. Some of the default information in the screenshots that
follow may have been cut out (not included) for brevity.

6.1 Log in Avaya SBCE

Use a Web browser to access the Avaya SBCE Web interface. Enter https://<ip-addr>/sbc in the
address field of the web browser, where <ip-addr> is the Avaya SBCE management IP address.

Enter the appropriate credentials and click Log In.

o v o a Log In
Username: username

Password:
Log In
Session Border Controller WELCOME TO AVAYA SBC
for Ente rprise Unauthorized access to this machine is prohibited. This system is for

the use authorized users only. Usage of this system may be monitored
and recorded by system personnel.

Anyone using this system expressly consents to such monitoring and
is advised that if such monitoring reveals possible evidence of criminal
activity, system personnel may provide the evidence from such
monitoring to law enforcement officials.

© 2011 - 2017 Avaya Inc. All rights reserved.

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 33 of 87
SPOC 10/29/2018 ©2018 Avaya Inc. All Rights Reserved. IronIPO11SBC72




The Dashboard main page will appear as shown below.

Alarms  Incidents  Status~ Logs~  Diagnostics  Users Settings v Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard

Administration
Backup/Restore
System Management

Global Parameters
Global Profiles The following certificates are expired:

+ Clearcom_Cert.crt (Certificate)

> PPM Services

> TLS Management System Time 04:25:22 PM EDT Refresh EMS

> Device Specific Settings Version 7220-11-15522 Avaya SBCE
Build Date Tue May 29 11:31:10 UTC 2018
License State @ 0K

Aggregate Licensing Overages 0

Peak Licensing Overage Count 0

Last Logged in at 07/11/2018 16:05:44 EDT

Failed Login Attempts 0

Active Alarms (past 24 hours) Incidents (past 24 hours)

None found Avaya_SBCE : No Subscriber Flow Matched

Avaya_SBCE : No Subscriber Flow Matched v

To view the system information that was configured during installation, navigate to System
Management. A list of installed devices is shown in the right pane. In the compliance testing, a
single Device Name Avaya SBCE was already added. To view the configuration of this device,
click on View as shown in the screenshot below.

Alarms  Incidents  Status~ Logs ~  Diagnostics  Users Settings ~ Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard System Management

Administration

Backup/Restore
System Management Devices H Updates u SSL VPN I_I Licensing H Key Bundles

Global Parameters Management
Global Profiles <

Device Name

Version Status

» PPM Services Avaya SBCE ?52552‘}”’ Commissioned Reboot Shutdown Restart Application Edit Uninstall
> Domain Policies
> TLS Management
> Device Specific Settings
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The System Information window is displayed as shown below.

The System Information screen shows the Network Configuration, DNS Configuration and
Management IP(s) information provided during installation and corresponds to Figure 1.

General Configuration Device Configuration ————————— - License Allocation
Appliance Name Avaya_SBCE HA Mode MNo EL?ES::S E:Dgsions 1000
Box Type SIP Two Bypass Mode No R 1000
Deployment Mode  Proxy FELTEEEEELL
Scopia Video Sessions 500
ke 0
1’;?5:50;::1 iglg Sessions
CLID —
S <
r Network Configuration
P Public IP Metwork Prefoc or Subnet Mask Gateway Interface
Al
| 10.64.101.243 10.64.101.243 255.255.255.0 10.64.101.53 Al |
Al
B1
B1
10.10.80.51 10.10.80.51 255.255.255.128 10.10.80.1 B1
r DNS Configuration Management IP(s)
Primary DNS 5.8.58 [ IP #1 (IPvd)
Secondary DNS 7777
DNS Location DMZ
DNS Client IP 10.10.80.51

On the previous screen, Al corresponds to the inside interface (Private Network side) and B1
corresponds to the outside interface (Public Network side) of the Avaya SBCE. (Refer to Figure 1).

The management IP was blurred out for security reasons. The IP addresses used for the remote
worker configuration were also blurred out since the remote worker configuration is beyond the
scope of these Application Notes and is not discussed in these Application Notes.

Note: Valid public DNS IP addresses are required with this solution.
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6.2 TLS Management

Transport Layer Security (TLS) is a standard protocol that is used extensively to provide a secure
channel by encrypting communications over IP networks. It enables clients to authenticate servers
or, optionally, servers to authenticate clients. UC-Sec security products utilize TLS primarily to
facilitate secure communications with remote servers.

For the compliance testing, the transport protocol that was used between IP Office and the Avaya
SBCE, across the enterprise private IP network (LAN), was SIP over TLS. SIP over UDP was used
between the Avaya SBCE and Ironton, across the public Internet.

It is assumed that generation and installation of certificates and the creation of TLS Profiles on the

Avaya SBCE have been previously completed, as it’s not discussed in this document. Refer to item
[10] in Section 10.

6.3 Global Profiles

The Global Profiles Menu, on the left navigation pane, allows the configuration of parameters across
all Avaya SBCE appliances.

6.3.1 Server Interworking — Avaya-IPO

Interworking Profile features are configured to facilitate interoperability of implementations between
enterprise SIP-enabled solutions and different SIP trunk service providers.

Several profiles have been already pre-defined and they populate the list under Interworking
Profiles on the screen below. If a different profile is needed, a new Interworking Profile can be
created, or an existing default profile can be modified or “cloned”. Since directly modifying a
default profile is generally not recommended, for the test configuration the default avaya-ru profile
was duplicated, or “cloned”. If needed, the profile can then be modified to meet specific
requirements for the enterprise SIP-enabled solution.

On the left navigation pane, select Global Profiles = Server Interworking (not shown). From the
Interworking Profiles list, select avaya-ru. Click Clone on top right of the screen (not shown).

Enter the new profile name in the Clone Name field, the name of Avaya-1PO was chosen in this
example. Click Finish.

Clone Profile X

Profile Name avaya-ru
|Clone MName Avaya-lPO |
Finish
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Click Edit on the newly cloned Avaya-1PO interworking profile:
e On the General tab, check T.38 Support.
e Leave remaining fields with default values.
e Click Finish.

Editing Profile: Avaya-IPO X

General

Hold Support (L) RFC2543 -¢=0.0.0.0
() RFC3264 - a=sendonly

130 Handling ® None O SDP ) No SDP
181 Handling ® None O SDP ) No SDP
182 Handling ® None O SDP () No SDP
183 Handling ® None O SDP O No SDP
Refer Handling O

URI Group Nane v

Send Hold

Delayed Offer
3xx Handling O

Diversion Header Support

Delayed SDP Handling |
Re-Invite Handling |
Prack Handling |
Allow 18X SDP
T.38 Support |
URI Scheme ®sip OTEL O ANY
Via Header Format . HRZERE
() RFC2543
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The following screen capture shows the General tab of the newly created Avaya-1PO Server
Interworking Profile.

Alarms  Incidents  Status~ Logs~  Diagnostics Users

Session Border Controller for Enterprise
Dashboard Interworking Profiles: Avaya-IPO
Administration Add
Backup/Restore
Interworking Profiles Click here to add a description.
System Management
cs2100
> Global Parameters General ||| Timers || Privacy | | URI Manipulation || Header Manipulation | | Advanced |
4| Global Profiles avaya-ru
] General
Domain DoS 0CS-Edge-Server
Server Interworking : Hold Support NONE
cisco-ccm
Media Forking 180 Handling None
. cups
Routing 181 Handling None
Server Configuration OCS-FrontEnd-Server )
o 1682 Handling None
Topology Hiding Avaya-SM
Signaling Manipulation 183 Handling None
g 9 P SP-General Refor Handii N
URI Groups eter Nandling o
Avaya-IPO
SNMP Traps URI Group None
Time of Day Rules Avaya-C31000 Send Hold No
FGDN Groups Avaya-CM
) Delayed Offer No
Reverse Proxy Policy
RADIUS 3xx Handling No
> PPM Services Diversion Header Support No
> Domain Policies Delayed SDP Handling No
> TLS Management Re-Invite Handling No
> Device Specific Settings
Prack Handling No
Allow 18X SDP No
T.38 Support Yes
URI Scheme SIP
Via Header Format RFC3261
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The following screen capture shows the Advanced tab of the newly created Avaya-1PO Server
Interworking Profile.

Alarms  Incidents  Status~ Logs~  Diagnostics  Users

Session Border Controller for Enterprise
Dashboard Interworking Profiles: Avaya-IPO
Administration Add
Backup/Restore
Interworking Profiles Click here to add a descnption.
System Management
cs2100
> Global Parameters General || Timers || Privacy ‘ | URI Manipulation || Header Manipulation || Advanced |
4 |Global Profiles avaya-ru
Domain DoS OCS-Edge-Senver Record Routes Both Sides
Server Interworking . Include End Point IP for Context Lookup Yes
- " cisco-ccm
Media Forking Extensions Avaya
. cups
Routing Diversion Manipulation No
version anipula
Server Configuration OCS-FrontEnd-Server
. Has Remote SBC Yes
Topology Hiding Avaya-SM
i i i i Route Response on Via Port No
Signaling Manipulation Sp-General pol
URI Groups Relay INVITE Replace for SIPREC No
Avaya PO
SNMP Traps MOBX R -
e-INVITE Handling No
Time of Day Rules Avaya-C31000
FGDN Groups Avaya-CM DTMF
Reverse Proxy Policy DTMF Support None
RADIUS
; Edit
> PPM Services
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6.3.2 Server Interworking - SP-General
A second Server Interworking profile named SP-General was created for the Service Provider.

On the left navigation pane, select Global Profiles - Server Interworking (not shown). From the
Interworking Profiles list, select Add (not shown) (note that Add is being used to create the SP-
General profile instead of cloning the avaya-ru profile).

Enter the new profile name, the name of SP-General was chosen in this example.
e Click Next.

Interworking Profile

| Profile Name SP-General |
Next
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On the General tab, check T.38 Support. Click Next, and then click Finish on the last tab leaving
remaining fields with default values (not shown).

Interworking Profile X

General

® None

Hold Support :' RFC2543 - ¢=0.0.0.0
L) RFC3264 - a=sendonly

180 Handling ® None O SDP O No SDP
181 Handling ® None O SDP O No SDP
182 Handling ® None O SDP O No SDP
183 Handling ® None O SDP O No SDP
Refer Handling |

URI Group Nane v

Send Hold v

Delayed Offer v
3xx Handling (|

Diversion Header Support

Delayed SDP Handling |
Re-Invite Handling O
Prack Handling [l
Allow 18X SDP
T.38 Support
URI Scheme ®sp O TEL O ANY
® RFC3261

Via Header Format
[ RFC2543
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The following screen capture shows the General tab of the newly created SP-General Server
Interworking Profile.

Alarms  Incidents  Status~ Logs~  Diagnostics Users

Session Border Controller for Enterprise
Dashboard Interworking Profiles: SP-General
Administration Add
Backup/Restore
Interworking Profiles Click here to add'a description.
System Management
cs2100
> Global Parameters General ” Timers H Privacy || URI Manipulation || Header Manipulation | | Advanced |
4 |Global Profiles avaya-fu
General
Domain Dos 0CS-Edge-Server e ——
Server Interworking ) Hold Support NONE
cisco-ccm
Media Forking 180 Handling None
. cups
Routing 181 Handling None
Server Configuration OCS-FrontEnd-Server )
o 182 Handling None
Topology Hiding Avaya-SM
Signaling Manipulation 183 Handiing None
SP-General
URI Groups Refer Handling No
Avaya-IPO
SNMP Traps y URI Group None
Time of Day Rules Avaya-C51000 Send Hold No
FGDN Groups Avaya-CM
. Delayed Offer No
Reverse Proxy Policy
RADIUS 3xx Handling No
> PPM Services Diversion Header Support No
> Domain Policies Delayed SDP Handling No
> TLS Management Re-Invite Handling No
> Device Specific Settings
Prack Handling No
Allow 18X SDP No
T.38 Support Yesl
URI Scheme SIP
Via Header Format RFC3261
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The following screen capture shows the Advanced tab of the newly created SP-General Server
Interworking Profile.

Alafms  Incidents  Status~  Logs~  Diagnostics  Users
Session Border Controller for Enterprise
Dashboard Interworking Profiles: SP-General
Administration Add
Backup/Restore
Interworking Profiles Click here to add'a description.
System Management
cs2100
> Global Parameters General || Timers H Privacy || URI Manipulation || Header Manipulation | | Advanced L
4| Global Profiles avaya-fu
Domain DoS 0CS-Edge-Server Record Routes Both Sides
Server Interworking . Include End Point IP for Context Lookup No
- - CIsCo-Cccm
Media Forking cups Extensions Neone
Routing G Diversion Manioulat N
) version ianipulation {a]
Server Configuration 0CS-FrontEnd-Server
- Has Remote SBC Yes
Topology Hiding Avaya-SM
i i i i Route Response on Via Port No
Signaling Manipulation SP.General po
URI Groups Relay INVITE Replace for SIPREC No
SNMP T Avaya-IPO
raps MOBX Re-INVITE Handling No
Time of Day Rules Avaya-C51000
FGDN Groups Avaya-CM DTMF
Reverse Proxy Policy DTMF Support None
RADIUS
; Edit
> PPM Services

6.3.3 Server Configuration

Server Profiles should be created for the Avaya SBCE’s two peers, the Call Server (IP Office) and
the Trunk Server or SIP Proxy at the service provider’s network.

To add the profile for the Call Server, from the Global Profiles menu on the left-hand navigation
pane, select Server Configuration (not shown). Click Add Profile (not shown) and enter the profile
name: IP Office.

e Click Next.

Add Server Configuration Profile

Profile Name IP Office |

On the Add Server Configuration Profile window:
e Server Type: Select Call Server.
e IP Address/FQDN: 192.168.128.167 (IP Address of IP Office).
e Port: 5061 (This port must match the port number defined in Section 5.4.2).
e Transport: Select TLS.
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e Selecta TLS Client Profile.
e Click Next.

|Sewer Type |Ca|l Server | V|
SIP Domain | |
DNS Query Type NONE/A Vv
|TLS Client Profile |RemoteWorkersCIientF‘rofile v ||
Add
IP Address / FQDN Port Transport
||192.168.]28.16?‘ | [5061 | [TLs | v| Delete

e Click Next on the Add Server Configuration Profile - Authentication window (not

shown).

e Click Next on the Add Server Configuration Profile - Heartbeat window (not shown).
e Click Next on the Add Server Configuration Profile - Registration window (not shown).
e Click Next on the Add Server Configuration Profile - Ping window (not shown).

On the Add Server Configuration Profile - Advanced tab:

e Select Avaya-1PO from the Interworking Profile drop down menu (Section 6.3.1).
e Leave the Signaling Manipulation Script at the default None.

e Click Finish.
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Enable DoS Protection O
Enable Grooming O
Interworking Profile [Avaya-IPO M |
Signaling Manipulation Script |Ncne V|
Securable O
Enable FGDN O
TCP Failover Port 5060
TLS Failover Port 5061
Tolerant O
URI Group
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The following screen capture shows the General tab of the newly created IP Office Server
Configuration Profile.

Alarms  Incidents Status~ Logs~ Diagnostics Users Settings v Help v  Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: IP Office
Administration Add | Rename H Clone H Delete |
Backup/Restore
System Management General ” Authentication U Heartbeat U Registration H Ping H Advanced }
CS1000
Global Parameters Server Type Call Server
4| Global Profiles Com Manager
" TLS Client Profile RemoteWorkersClientProfile
Domain DoS SP_SC
Server Interworking DNS Query Type NONE/A
. K Service Provider ...
Media Forking ) IP Address / FQDN Port Transport
Routing Session Manager
_ [192.168.128.167 5061 TLS |

Server Configuration IP Office

Topology Hiding Service Provider...

Signaling Manipulation

URI Groups
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The following screen capture shows the Advanced tab of the newly created IP Office Server
Configuration Profile.

Alarms  Incidents  Statlus~ Logs v  Diagnostics Users Settings v Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard ~ Server Configuration: IP Office
Administration Add ‘ Rename || Clone H Delete |
Backup/Restore
System Management General U Authentication u Heartbeat U Registration U Ping U Advanced |
Global Parameters Gs1000 .
Enable DoS Protection O

4 | Global Profiles Com Manager

Domain DoS SP.SC Enable Grooming O

Server mler-wmk‘ng Service Provide. . Interworking Profile Avaya-IPO |

Media Forking Session Manager Signaling Manipulation Script None

Routing

Configuration Service Provide... Enable FGDN O

Topology Hiding

Signaling Tolerant U

Manipulation URI Group None

URI Groups

SNMP Traps

Time of Day Rules

To add the profile for the Trunk Server, from the Server Configuration screen, click Add in the
Server Profiles (not shown) section and enter the profile name: Service Provider UDP.

e Click Next.

Add Server Configuration Profile

Profile Name vice Provider UDP

Next
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On the Edit Server Configuration Profile - General window:
e Server Type: Select Trunk Server.
e DNS Query Type: Select NONE/A
e IP Address / FQDN: sip.test.com (Ironton’s SIP proxy server FQDN).
e Port: 5060.
e Transports: Select UDP.

e Click Next.

| Server Type [Trunk Server V||
SIP Domain | |

[DNS Query Type NONE/A v| |

TLS Client Profile None v

Add

IP Address / FQDN Port Transport

||sip.test.cum | |506[I | [upP V|i Delete

On the Add Server Configuration Profile - Authentication tab:
e Check the Enable Authentication box.

e Enter the User Name credential provided by the service provider for SIP trunk registration,
the pilot number provided by Ironton for registration purpose was used.

e Leave the Realm blank.
e Enter Password credential provided by the service provider for SIP trunk registration.
e Click Next.

Add Server Configuration Profile - Authentication

Enable Authentication [+
User Name
{Leave blank to detect from server challenge)
Confirm Password

e Click Next on the Add Server Configuration Profile - Heartbeat window (not shown).

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 47 of 87
SPOC 10/29/2018 ©2018 Avaya Inc. All Rights Reserved. IronIPO11SBC72



On the Add Server Configuration Profile - Registration tab:

e Check the Register with All Servers box.

e Frequency: Enter the amount of time (in seconds) between REGISTER messages that will
be sent from the enterprise to the Service Provider Proxy Server to refresh the registration
binding of the SIP trunk. This value should be chosen in consultation with the service
provider. 30 seconds was the value used during the compliance test.

e The From URI and To URI entries for the REGISTER messages are built using the
following:

- From URI: Use the User Name entered above in the Authentication screen
(16107941234) and the Service Provider’s SIP proxy server FQDN (sip.test.com), as
shown on the screen below.

- To URI: Use the User Name entered above in the Authentication screen (16107941234)
and the Service Provider Proxy Provider’s domain name (sip.test.com), as shown on the
screen below.

- Click Next.
Add Server Configuration Profile - Registration X
Register with All Servers

Register with Pricnity Server

Refresh Interval |30 | seconds
From URI [16107941234@sip.test]
To UR [7941234@sip.test.com |
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Click Next on the Add Server Configuration Profile - Ping window (not shown).

On the Add Server Configuration Profile - Advanced window:
e Select SP-General from the Interworking Profile.

e Leave all other fields with default values.
e Click Finish.

Enable DeS Protection Il
Enable Groeming
Interworking Profile [sP-General | v
Signaling Manipulation Script |Nune V|
Securable Il
Enable FGDN Il
TCP Failover Port 5060
TLS Failover Port 5061
Tolerant Il
URI Group
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The following screen capture shows the General tab of the newly created Service Provider UDP
Server Configuration Profile.

SPOC 10/29/2018

©2018 Avaya Inc. All Rights Reserved.

Alarms 1 Incidents  Status~ Logs~  Diagnostics Users Settings v Help ~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard A Server Configuration: Service Provider UDP
Administration Add ‘ Rename H Clone H Delete ‘
Backup/Restore
System Management General H Authentication H Heartbeat H Registration H Ping H Advanced I
CS51000
> Global Parameters Server Type Trunk Server
4 |Global Profiles Com Manager
i DNS Query Type NONE/A
Domain DoS SP-SC
Server Interworking ) ) IP Address / FQDN Port Transport
) . Service Provi...
Media Forking [ sip-test.com 5060 UDP|
Routing IP Office
Server Session Man_...
Configuration
Topology Hiding
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The following screen capture shows the Authentication tab of the newly created Service Provider
UDP Server Configuration Profile.

Alarms 1 Incidents

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

« [Goba Prfis]
Domain DeS
Server Interworking
Media Forking
Routing

Server
Configuration

Topology Hiding

Status v

~

Logs v

Diagnostics

Users Settings v

Session Border Controller for Enterprise

Server Configuration: Service Provider UDP

Add

Server Profiles

CS1000

Com Manager
SP-SC
Service Provi
IP Office

Session Man...

Service Prov...

Help ~

Log Out

AVAYA

‘ Rename H Clone H Delete ‘

General “ Authentication ” Heartbeat H Registration H Ping H Advanced I

Enable Authentication W]
User Name 16107941234
Realm
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The following screen capture shows the Registration tab of the newly created Service Provider
UDP Server Configuration Profile.

Alarms 1 Incidents Statusv~ Logsv  Diagnostics Users Settings v Help v  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard A Server Configuration: Service Provider UDP
Administration Add ‘ Rename H Clone H Delete ‘
Backup/Restore
System Management General H Authentication H Heartbeat “ Registration H Ping H Advanced I
> Global Parameters €s1000 -
Register with All Servers i

4| Global Profiles Com Manager

Domain DoS sp.sc Register with Priority Server O

Serv.er Interworking S B Refresh Interval 30 seconds

MEd'_a Forking P Office From URI 16107941234@sip test com

Routing )

Server Sreshm L To URI 16107941234@sip test.com

Configuration

Topology Hiding
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The following screen capture shows the Advanced tab of the newly created Service Provider UDP
Server Configuration Profile.

Alarms 1 Incidents Status v Logsv  Diagnostics Users Settings v Help v  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard ~ Server Configuration: Service Provider UDP
Administration Add ‘ Rename H Clone H Delete ‘
Backup/Restore
System Management General H Authentication H Heartbeat H Registration H Ping “ Advanced |
> Global Parameters Cs1000
Enable DoS Protection O

4 Global Profiles Com Manager

Domain DoS sp.sc Enable Grooming i

Serv.er Imerwcrking el Interworking Profile SP-GeneraIl

MEdl_a Forking |P Office Signaling Manipulation Script None

Routing

Server Session Mana... Securable o

Configuration Enable FGDN O

Topology Hiding

Signaling Tolerant O

Manipulation URI Group None

URI Groups

SNMP Traps
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6.3.4 Routing Profiles

Routing profiles define a specific set of routing criteria that are used, in conjunction with other types
of domain policies, to determine the route that SIP packets should follow to arrive at their intended
destination.

Two Routing profiles were created, one for inbound calls, with IP Office as the destination, and the
second one for outbound calls, which are sent to the Service Provider SIP trunk.

To create the inbound route, from the Global Profiles menu on the left-hand side (not shown):
e Select Routing (not shown).
e Click Add in the Routing Profiles section (not shown).
e Enter Profile Name: Route_to IPO_TLS.
e Click Next.

Routing Profile

|Proﬂle Name Route_ta_IPO_I x |

Next

On the Routing Profile screen complete the following:
e Click on the Add button to add a Next-Hop Address.
e Priority / Weight: 1
e Server Configuration: Select IP Office.

e Next Hop Address is populated automatically with 192.168.128.167:5061 (TLS) (IP Office
IP address, Port and Transport).

e Click Finish.
URI Group Time of Day
Lead Balancing | Priority ~v|  NAPTR
Transport None v Next Hop Priority 1
MNext Hop In-Dialog [] Ignore Route Header  []
ENUM O ENUM Suffix

Priority /
Weight

Server Configuration  Next Hop Address Transport

||1 | [IP Office w| [192.168.128.167:5061 (TLS) v|| None “| Delete
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The following screen shows the newly created Route_to IPO_TLS Routing Profile.

Alaftms 3 Incidents  Status~  Logs~  Diagnostics  Users Setlings Help ~ Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles:|Ro ute_lo_IF’O_TLS|
Administration

Add ‘ Rename H Clone || Delete |
Backup/Restore

Routing Profiles Click here to add a descripfion.
System Management ick-here to add a description

> Global Parameters G m‘
e Route_to_SM
Domain DoS Route_to_CM ik
Server Interworking Route to IPO U.. Priority gfﬂup 'g::e i Load Balancing Next Hop Address Transport
Media Forking -
To SMfrom Rem... | . default Priority 192.168.128.167 TLS| Edit Delete
Server Configuration To IPO from Re...
Topology Hiding
Signaling Manipulation

Route to SP_TLS

URI Groups

Similarly, for the outbound route:
e Select Routing (not shown).
e Click Add in the Routing Profiles section (not shown).
e Enter Profile Name: Route_to SP_UDP.
e Click Next.

Routing Profile

Profile Name ite_to_SP_UDP| x

Next
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On the Routing Profile screen complete the following:
e Load Balancing: Select DNS/SRV.
e Click on the Add button to add a Next-Hop Address.
e Server Configuration: Select Service Provider UDP.

e Next Hop Address is populated automatically with sip.test.com:5060 (UDP) (Service
Provider SIP Proxy FQDN, Port and Transport).

e Click Finish.

Routing Profile X

URI Group Time of Day
[Load Balancing  [DNS/SRV_| v| NAPTR 0

Transport None Vv Next Hop Priority

Next Hop In-Dialog  [] Ignore Route Header  []

ENUM (| ENUM Suffix

Priority /
Weight

Server Configuration

Next Hop Address

| ‘Service Provider V| |sip.test.cnm:5060 (UDP)

V|| None W| Delete

Transport

The following screen capture shows the newly created Route_to_SP_UDP Routing Profile.

Alarms 1 Incidents

Dashboard
Administration
Backup/Restore

System Management

Status v Logs v

~

Diagnostics

Users

Session Border Controller for Enterprise

Routing Profiles: Route_to_SP_UDP

Add

Routing Profiles Click here to add a description.

default

Settings v Help v Log Out

AVAYA

| Rename || Clone H Delete |

+ Global Parameters Routing Profile
4 |Global Profiles Route_to_SM
Domain DoS Route 1o M
i o URI Time Load ce
Server Interworking Route_to_IPO... Priofty  Gioup of Day  Balancing Next Hop Address Transport
Media Forking
UDSIEDR. | - default DNS/SRY siptest.com UDP| Edit Delete
Server To IPO from R
Configuration Route o IPO
Topology Hidin -
R P .gy < Route_to SP...
Signaling
Manipulation Route_to_CS
SNMP Traps
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6.3.5 Topology Hiding

Topology Hiding is a security feature which allows changing several parameters of the SIP packets,
preventing private enterprise network information from being propagated to the untrusted public
network.

Topology Hiding can also be used as an interoperability tool to adapt the host portion in SIP headers
like To, From, Request-URI, Via, Record-Route and SDP to the IP addresses or domains expected
by IP Office and the SIP trunk service provider, allowing the call to be accepted in each case.

For the compliance test, only the minimum configuration required to achieve interoperability on the
SIP trunk was performed. Additional steps can be taken in this section to further mask the
information that is sent from the Enterprise to the public network.

To add the Topology Hiding Profile in the Enterprise direction, select Topology Hiding from the
Global Profiles menu on the left-hand side (not shown):

e Click on default profile and select Clone (not shown).
e Enter the Profile Name: IP Office.
e Click Finish.

Clone Profile X

Profile Name default
|Clone Name IP Office |

The following screen capture shows the newly added IP Office Topology Hiding Profile. Note that
for IP Office no values were overwritten (left with default values).

Alarms 3 Incidents  Status~  Logs~  Diagnostics  Users Settings Help ~  Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: IP Office
Backup/Restore
Topelogy

Systern Management Click here to add a descripfion.
> Global Parameters default Topology Hiding
4| Global Profiles .

Domain DoS cisco_th_profile Replace Action Overwrite Value

Server Interworking Session_Manager Refer-To IP/Domain Auto

Media Forking Service_Provider Referred-By IP/Domain Auto

Routing Com Manager Record-Route IP/Domain Auto

Server Configuration

T . Hiding CS1000 Request-Line IP/Domain Auto

opology

Signaling Manipulation IP Office To IP/Domain Auto

URI Groups From IP/Domain Auto

SNMP Traps SDP IP/Domain Auto

Time of Day Rules Via IP/Domain Auto

FGDN Groups

Reverse Proxy Policy

RADIUS
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To add the Topology Hiding Profile in the Service Provider direction, select Topology Hiding from
the Global Profiles menu on the left-hand side (not shown):
e Click on default profile and select Clone (not shown).

e Enter the Profile Name: Service_Provider.

e Click Finish.
Clone Profile X
Profile Name default
|Clone Name Service_Provider |

e Click Edit on the newly created Service_Provider Topology Hiding profile.

e On the From choose Overwrite from the pull-down menu under Replace Action, enter the
domain name for the service provider (sip.test.com) under Overwrite Value.

e On the Request-Line choose Overwrite from the pull-down menu under Replace Action,
enter the domain name for the service provider (sip.test.com) under Overwrite Value.

e On the To choose Overwrite from the pull-down menu under Replace Action, enter the
domain name for the service provider (sip.test.com) under Overwrite Value.

e Click Finish.

Header Criteria Replace Action Overwrite Value

‘Recnrdeoute V‘ ‘\P!Domain V‘ ‘ALIICI V| Delete
[Via v| [IPIDomain V]| [Auto V| Delete
‘Referred—By V‘ ‘\P!Domain V‘ ‘Auto V| Delete
|‘Frum V‘ ‘\P/Domain V‘ ‘Overwrile V| ‘sip.tasl.cum || Delete
[Refer-To v| [IPiDomain | [Auto v| Delete
|‘Request—Line V‘ ‘\P!Domain V‘ ‘Overwrite V| ‘sip.‘tast.com || Delete
[sbp ~| [IPDomain V| [Auto M Delete
|‘T0 V‘ ‘\P/Domain V‘ ‘Overwrile V| ‘sip.tasﬂ.cum X” Delete
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The following screen capture shows the newly added Service_Provider Topology Hiding Profile.

Alarms 1 Incidents  Status v Logs v  Diagnostics Users

Session Border Controller for Enterprise

Dashboard Topology Hiding Profiles: Service_Provider

Administration Add

Settings v

Help v Log Out

AVAYA

| Rename || Clone H Delete |

Backup/Restore -
Topology Hiding Click here to add a description.
System Management Profiles

> Global Parameters default Topology Hiding
4 |Global Profiles
Domain DoS cisco_th_profile Header Criteria Replace Action Overwrite Value
Server Interworking Session_Man.. Record-Route IP/Domain Auto -
Media Forking Via IP/Domain Auto =
Routing Com Manager Referred-By IP/Domain Auto -
Server Configuration :
— CS51000 |From IP/Domain Overwrite S\ptest.coml
Topology Hiding
Signaling Manipulation IP Office Refer-To IP/Domain Auto —
URI Groups |Requesl-une IP/Domain Overwrite sip.test.com |
SNMP Traps SDP IP/Domain Auto -
Time of Day Rules |To IP/Domain Overwrite sip test,com|
FGDN Groups
Reverse Proxy Policy

RADIUS
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6.4 Domain Policies

Domain Policies allow configuring, managing and applying various sets of rules designed to control
and normalize the behavior of call flows, based upon various criteria of communication sessions
originating from or terminating in the enterprise.

6.4.1 Application Rules

Application Rules defines which types of SIP-based Unified Communications (UC) applications the
Avaya SBCE will protect: voice, video, and/or Instant Messaging (IM). In addition, Application
Rules defines the maximum number of concurrent voice and video sessions the network will process
in order to prevent resource exhaustion.

From the menu on the left-hand side, select Domain Policies = Application Rules (not shown).
e Click on the Add button to add a new rule (not shown).
e Rule Name: enter the name of the profile, e.g., 500 Session.

e Click Next.

Application Rule

Rule Name 500 Session

Next

e Under Audio check In and Out and set the Maximum Concurrent Sessions and Maximum

Sessions Per Endpoint to recommended values; the value of 500 was used in the sample

configuration.
e Click Finish.

HG; Reviewed:
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Video O O
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The following screen capture shows the newly created 500 Sessions Application Rule.

Alatms 3 Incidents  Status~  Logs~  Diagnostics  Users Settings ~ Help v~  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: 500 Sessions

Administration

Add ‘Fllter By Device | | Rename H Clone || Delete |
Backup/Restore

System Management Application Rules Click here to add/a description.
» Global Parameters etanit Application Rule

> Global Profiles default-trunk
— Maximum Concurrent Maximum Sessions Per
» PPM Services default-subscribe... Appiication Type I Out g2l Endpomt s
P - —
Domain .Polllmes default-subscribe. .. |Audig ¥ & 500 500 |
Application Rules
Border Rules default-server-low Video O 0O
Media Rules default-server-high
Signaling Rules CDR Support Off
500 Sessions
End Point Policy RTCP Keep-Alive No
Groups Remote-Workers
Session Palicies
> TLS Management
> Device Specific Settings
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 61 of 87

SPOC 10/29/2018 ©2018 Avaya Inc. All Rights Reserved. IronIPO11SBC72



6.4.2 Media Rules

Media Rules allow one to define RTP media packet parameters such as prioritizing encryption
techniques and packet encryption techniques. Together these media-related parameters define a strict
profile that is associated with other SIP-specific policies to determine how media packets matching
these criteria will be handled by the Avaya SBCE security product. For the compliance test, two
media rules (shown below) were used; one toward IP Office and one toward the Service Provider.

To add a media rule in the IP Office direction, from the menu on the left-hand side, select Domain
Policies 2 Media Rules.

e Click on the Add button to add a new media rule (not shown).

e Under Rule Name enter IPO_SRTP.

e Click Next.
Media Rule
[ Name [Fosmir_«]
MNext
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e Under Audio Encryption, Preferred Format #1, select
SRTP_AES _CM_128 HMAC_SHA1_80.

e Under Audio Encryption, Preferred Format #2, select RTP.

e Under Audio Encryption, uncheck Encrypted RTCP.

e Under Audio Encryption, check Interworking.

Repeat the above steps under Video Encryption.

Under Miscellaneous check Capability Negotiation.

Click Next.

Media Rule X

Audio Encryption
Preferred Format #1 [SRTP_AES_CM_128_HMAC_SHA1_80 V]|
Preferred Format #2 [RTP v
Preferred Format #3 [NONE M
Encrypted RTCP 0|
MKI O
Lifetime
Leave blank to match any value. 2n I:I

| Interworking |

Video Encryption
Preferred Format #1 |SRTP_AES_CM _123_HMAC_SHA1_80 V|
Preferred Format #2 [RTP M
Preferred Format #3 [NONE V]
Encrypted RTCP 0O |
MKI1 O
Lifetime
Leave blank to match any value. 2 I:I

| Interworking [~ |

Miscellaneous

|Capabi|ity Negotiation |

e Accept default values in the remaining sections by clicking Next (not shown), and then click
Finish (not shown).
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The following screen capture shows the newly created IPO_SRTP Media Rule

Alarms  Incidents

Logs ~  Diagnostics

Users Settings ~ Help ~ Log Out

Session Border Controller for Enterprise

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
> Global Profiles

> PPM Services

4| Domain Policies

AVAYA

Media Rules: IPO_SRTP

Add

[Filter By Device... v

‘ Rename H Clone H Delete |

Media Rules Click here to add a description.

default-low-med
default-low-med-enc
default-high

default-high-enc

Encryption ” | Codec Prioritization | | Advanced ‘ QoS

Audio Encryption

Preferred Formats ?{?;P_AES_CM_128_HMAC_5HA1_ED

Application Rules

Border Rules avaya-low-med-enc Encrypted RTCP 0
Media Rules Rem_Workers_SRTP MKI O

Security Rules

Lifetime Any

Signaling Rules ServiceProvider SRTP

End Point Policy

| Interworking [} |

Groups SM_SRTP
Session Policies Sl E R
- TLS Management Preferred Formats SRTP_AES_CM_128_HMAC_SHAT 20
» Device Specific Settings
Encrypted RTCP O
MKI O
Lifetime Any
|Inlarworking M |
Miscellaneous
| Capability Negotiation vl |

For the media rule in the Service Provider direction, the existing/predefined media rule default-low-
med was used.
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6.4.3 End Point Policy Groups

End Point Policy Groups are associations of different sets of rules (Media, Signaling, Security, etc.)
to be applied to specific SIP messages traversing through the Avaya SBCE.

To create an End Point Policy Group for the Enterprise, from the Domain Policies menu, select End
Point Policy Groups (not shown).

e Click on the Add button to add a new policy group (not shown).

e Group Name: Enterprise.
Click Next.

Policy Group

Group Name Enterprise| X | |

e Application Rule: 500 Sessions.

e Border Rule: default.

e Media Rule: IPO_SRTP (Section 6.4.2).
e Security Rule: default-low.

e Signaling Rule: default.

e Click Finish.

Application Rule |50[] Sessions V|
Border Rule |defau|t V|
Media Rule [IPO_SRTP v|
Security Rule
Signaling Rule |c|efau|t V|
Charging Rule
RTCP Monitoring Report Generation Off hd
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The following screen capture shows the newly created Enterprise End Point Policy Group.

Alarms 1 Incidents  Status v Logs v  Diagnostics Users Settings v Help v Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Policy Groups: Enterprise A

Administration

Backup/Restore

System Management

» Global Parameters

» Global Profiles

> PPM Services

L
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Charging Rules

End Point Policy
Groups

» Device Specific Settings

Add ‘Filter By Device... V|

Policy Groups

default-low
default-low-enc
default-med
default-med-enc
default-high
default-high-enc
OCS-default-...
avaya-def-low...
avaya-def-hig..

avaya-def-hig..

Session Policies
> TLS Management . ]
Service Provi..

| Rename H Clone H Delete |

Click here fo add a descripfion

Hover over a row to see its description.

Policy Group

Order Application Border Media

Security Signaling Charging

RTCP
Mon
Gen

500
Sessions

default IPO_SRTP

[

default-
low

default

None

Off | Edit

Similarly, to create an End Point Policy Group for the Service Provider SIP Trunk.
e Click on the Add button to add a new policy group (not shown).
e Group Name: Service Provider.
e Click Next.

Policy Group

Group Name Service Provider |

Next
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e Application Rule: 500 Sessions.
e Border Rule: default.

e Media Rule: default-low-med.

e Security Rule: default-low.

e Signaling Rule: default.

e Click Finish.

Policy Group X

Application Rule |500 Sessions V|
Border Rule [default v

Media Rule [default-low-med v
Security Rule

Signaling Rule |default hd
Charging Rule

RTCP Monitoring Report Generation Off v

The following screen capture shows the newly created Service Provider End Point Policy Group.

Alarms  Incidents  Status~ Logs~  Diagnostics  Users Settings v Help ~  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Policy Groups: Service Provider
Administration

~

Add |F|Iter By Device... V\ ‘ Rename H Clone H Delete |
Backup/Restore

Policy Groups Glick here to add a descripfion.
System Management
default-low
Global Parameters Hover over a row to see its description.

Global Profiles default-low-enc

PPM Services ernimed m‘

4
W default-med-enc
Application Rules
Border Rules default-high Order Application  Border Security Signaling Charging
Media Rules default-high-enc
Security Rules 0OCS-default-high ||Z| gjeusswons default ggzu\t-lnw- default-low  default None off Edit
Signaling Rules avaya-det-low-enc
Charging Rules
_ — avaya-def-high-..
End Point Policy
Groups avaya-def-high-..
Session Policies Enterprise
TLS Management
Device Specific Settings
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6.5 Device Specific Settings

The Device Specific Settings allow the management of various device-specific parameters, which
determine how a particular device will function when deployed in the network. Specific server
parameters, like network and interface settings, as well as call flows, etc. are defined here.

6.5.1 Network Management

The network information should have been previously completed. To verify the network
configuration, from the Device Specific Settings on the left-hand side, select Network
Management. Select the Networks tab.

In the event that changes need to be made to the network configuration information, they can be
entered here.

Use Figure 1 as reference for IP address assignments.

Note: Only the highlighted entity items were created for the compliance test, and are the ones
relevant to these Application Notes. Blurred out items are part of the Remote Worker configuration,
which is not discussed in these Application Notes.

Alarms 1 Incidents Statusv Logs v  Diagnostics Users Settings v Help ¥ Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Network Management: Avaya_SBCE
Administration

Backup/Restore
Devices
System Management _ Interfaces u Networks |
> Global Parameters Avaya_SBCE

> Global Profiles Subnol Mask
Subne asl o
» PPM Services Name Gateway Prefix Length Interface IP Address

> Domain Policies

LS Management Network A1 106410153 2552552550 Al 1064101243, | Edit Delete
4| Device Specific Settings
Network Network_B1  10.10.80.1 255255265128 B1 Edit Delete
Management 10.10.80.51
Media Interface
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On the Interfaces tab, click the Status control for interfaces A1 and B1 to change the status to
Enabled. It should be noted that the default state for all interfaces is Disabled, so it is important to
perform this step or the Avaya SBCE will not be able to communicate on any of its interfaces.

Alarms 1 Incidents  Status v Logs v  Diagnostics Users Settings v Help v Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Network Management: Avaya_SBCE

Administration

Backup/Restore .
System Management Interfaces | Networks
+ Global Parameters Avaya_SBCE
> Global Profiles
Interface Name VLAN Tag Status
> PPM Services
R [a1 Enabled|

> Domain Policies
> TLS Management A2 Disabled
4 [Device Specific Settings [B1 Enabled |

Network B2 Disabled

Management
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6.5.2 Media Interface

Media Interfaces were created to adjust the port range assigned to media streams leaving the
interfaces of the Avaya SBCE. On the Private and Public interfaces of the Avaya SBCE, the port
range 35000 to 40000 was used.

From the Device Specific Settings menu on the left-hand side, select Media Interface (not shown).
e Select Add in the Media Interface area (not shown).
e Name: Private_med.
e Under IP Address select: Network Al (A1, VLAN 0)
e Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBCE, toward IP Office).
e Port Range: 35000-40000.

e Click Finish.
Name | Private_med |
[Netwark_A1 (A1, VLAND) V|
IP Address

e Select Add in the Media Interface area (not shown).

e Name: Public_med.

e Under IP Address select: Network _B1 (B1, VLAN 0)

e Select IP Address: 10.10.80.51 (Outside IP Address of the Avaya SBCE, toward the Service

Provider).

e Port Range: 35000-40000.

e Click Finish.
Name | Public_med |

[Network_B1 (B1.VLAND) V|
IP Address
Port Range -[30000 ]
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The following screen capture shows the newly created Media Interfaces.

Alarms 1 Incidents

Status v

Users

Logs v

Diagnostics

Session Border Controller for Enterprise

Settings v

Help v

Log Out

AVAYA

Dashboard Media Interface: Avaya_SBCE
Administration
Backup/Restore
Devices i
System Management _ Media Interface
+ Global Parameters Avaya_SBCE
Modifying or deleting an existing media interface will require an application restart before taking
> Global Profiles effect. Application restaris can be issued from System Management.
» PPM Services
» Domain Policies
> TLS Management Name Sl Port Range
4 |Device Specific Settings
| P gs | |anate_med O 2 ) 35000 - 40000| Edit Delete
Network Management = .
i 5 10.64.101.244
Media Interface RW_Private_med Network. A1 (A VLAN 0) 35000 - 40000 Edit Delete
Signaling Interface
) RW_Public_Med 10.10.80.24 35000 - 40000 Edit Delete
End Point Flows - - Network_B1 (B1, VLAN 0)
Session Flows : 10.10.80.51 i
i Public_med Network BT (B1, VLAN 0) 35000 - 40000 Edit Delete
» DMZ Services
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6.5.3 Signaling Interface
To create the Signaling Interface toward IP Office, from the Device Specific menu on the left-hand
side, select Signaling Interface (not shown).
e Select Add in the Signaling Interface area (not shown).
e Name: Private_sig.
e Under IP Address select: Network Al (A1, VLAN 0)
e Select IP Address: 10.64.101.243 (Inside IP Address of the Avaya SBCE, toward IP Office).
e TLS Port: 5061.
e Selecta TLS Profile.

e Click Finish.
Add Signaling Interface X
Name | Private_sig |
[Network_A1 (A1.VLAND) |
IP Address
10.64.101.243 W

TCP Port | |
Leave blank to disable
UDP Port | |
Leave blank to disable
TLS Port
Leave bEank to disable |506-I |

TLS Profile [NewRemoteWorkerServerProfile |

Enable Shared Control O

Shared Control Port
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 72 of 87

SPOC 10/29/2018 ©2018 Avaya Inc. All Rights Reserved. IronIPO11SBC72



e Select Add in the Signaling Interface area (not shown).

e Name: Public_sig.

e Under IP Address select: Network_B1 (B1, VLAN 0)
e Select IP Address: 10.10.80.51 (outside or public IP Address of the Avaya SBCE, toward

the Service Provider).
e UDP Port: 5060.
e Click Finish.

Add Signaling Interface X

Leave blank to disable

Name |F’ub|ic_sig |
[Network_B1(B1,VLAND) V|
IP Address
10.10.8051 v
TCP Port

UDP Port

Enable Shared Control

Shared Control Port

Leave blank to disable |5060 | |
TLS Port | |
Leave blank to disable

TLS Profile None

The following screen capture shows the newly created Signaling Interfaces.

Alarms 1 Incidents  Status v  Logs v

Dashboard
Administration
Backup/Restore

Devices

System Management

Diagnostics

Users

Session Border Controller for Enterprise

Signaling Interface: Avaya_SBCE

Signaling Interface

Settings v

Help ¥ Log Out

AVAYA

> Global Parameters Avaya_SBCE
Modifying or deleting an existing signaling interface will require an application restart before taking
> Global Profiles effect. Application restarts can be issued from System Management.
> PPM Services
> Domain Policies
> Signaling IP TCP UDP TLS =
TLS Management Name Sl Pot Pott Port TLS Profile
4 |Device Specific Settings|
. . 10.64.101.243
Network Management Private_sig mg;ﬁm (A1, — 5060 5061 NewRemoteWorkerServerProfile  Edit | [
Media Interface
Signaling Interface Edit O
End Point Flows
Session Flows Edit O
> DMZ Services
o 10.10.80.51
TURN/STUN Service Public_sig Network_B1 (B1, 5060 — None Edit | O
VLAN 0]
SNMP
Syslog Management < 2
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6.5.4 End Point Flows

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URIs, etc.) is
used to determine which flow it matches. Once the flow is determined, the flow points to a policy
group which contains several rules concerning processing, privileges, authentication, routing, etc.
Once routing is applied and the destination endpoint is determined, the policies for this destination
endpoint are applied. The context is maintained, so as to be applied to future packets in the same
flow. The following screen illustrates the flow through the Avaya SBCE to secure a SIP Trunk call.

“Trunk Server”

“Call Server to “Cﬂ," Server’ Applied "Trunk Server to .

SBC” Flow Policy Group Reriig SBC" Flow Policy Group E
: 8

£ q
i % 8
a 2

\ = Piﬁ!ys g:\;i: “Call Server to Applied ;':lr;k SG‘i:e;l “Trunk Server to é \
SBC'F i icy Grou ’ :
low Routing SBC” Flow E
a
]
Avaya SBCE
.
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The End-Point Flows define certain parameters that pertain to the signaling and media portions of a
call, whether it originates from within the enterprise or outside of the enterprise.

To create the call flow toward the Service Provider SIP trunk, from the Device Specific Settings
menu, select End Point Flows (not shown), then the Server Flows tab. Click Add (not shown).

Name: SIP_Trunk_Flow_UDP.
Server Configuration: Service Provider UDP.

URI Group: *

Transport: *

Remote Subnet: *

Received Interface: Private_sig.

Signaling Interface: Public_sig.

Media Interface: Public_med.

Secondary Media Interface: None.

End Point Policy Group: Service Provider.
Routing Profile: Route_to IPO_TLS (Note that this is the reverse route of the flow).
Topology Hiding Profile: Service_Provider.
File Transfer Profile: None.

Signaling Manipulation Script: None.
Remote Brach Office: Any.

Click Finish.
Flow Name ‘SIPﬁTrunkﬁF\uwﬁUDP x |

Server Configuration

URI Group

1 [+ [o]
0]
<.

< 8
Y
g

< |5
m
2
c
)
el
<

Transport

Remote Subnet

Received Interface Private_sig
Signaling Interface Public_sig
Media Interface Public_med

Secondary Media Interface None

) ]
@
2
Q
[+]
e
[=]
£.
(=%
a
< l< | £

End Point Policy Group v|

Routing Profile [Route_to_IPO_TLS V|
Topology Hiding Profile
Signaling Manipulation Script \None v
Remote Branch Office Any V¥
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To create the call flow toward IP Office, click Add (not shown).

e Name: IP_
e Server Configuration: IP Office.

Office_Flow.

e URI Group: *
e Transport: *
e Remote Subnet: *

e Received Interface: Public_sig.

e Signaling Interface: Private_sig.

e Media Interface: Private_med.

e Secondary Media Interface: None.

e End Point Policy Group: Enterprise.
e Routing Profile: Route_to_SP_UDP (Note that this is the reverse route of the flow).

e Topology Hiding Profile: IP Office.

e File Transfer Profile: None.
e Signaling Manipulation Script: None.
e Remote Brach Office: Any.
e Click Finish.

Edit Flow: IP_Office_Flow X

Flow Name

Server Configuration

URI Group

Transport

Remote Subnet

Received Interface
Signaling Interface

Media Interface
Secondary Media Interface
End Point Policy Group

Routing Profile

[IP_Office_Flow

x]

[IP Office v

!
£

- |

Public_sig v

Private_sig
Private_med

MNone

[Enterprise

v]

[Route_to_SP_UDP V|

Topology Hiding Profile IP Office v
Signaling Manipulation Script |None
Remote Branch Office
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The following screen capture shows the newly created End Point Flows.

Alarms 1 Incidents ~ Status v Users

Logs ~

Diagnostics

Settings ~

Help ~ Log Out

Session Border Controller for Enterprise AVAYA
Dashboard End Point Flows: Avaya_SBCE
Administration
Backup/Restore
Devices il
System Management Subscriber Flows |I Server Flows |
> Global Parameters Avaya SBCE Add
» Global Profiles - -
Click here to add a row description.
> PPM Services
. : r Server C ation: IP Office
» Domain Policies =
» TLS Management
4| Device Specific Settings URI Fresrez] St End Point
Priority  Flow Name ~ i g .g Policy Routing Profile
Network Management : Group Interface Interface Gruué
Media Interface
Signaling Interface i defaull View Clone Edit Delete
End Point Flows
Session Flows |IP70Fﬁce7F\ow ® Public_sig Private_sig Enterprise  Route_to SP_UDP | View Clone Edit Delete
> DMZ Services
TURN/STUN Service r Server Configuration: Service Provider UDP
End
SNMP _ URI Received Signaling Point
Priority  Flow Name o P g ofich Routing Profile
Syslog Management Group  Interface Interface gr:l:;{:y
Advanced Options
> Troubleshooting D |S\F_Trunk_FIow_UDP " Private_sig  Public_sig g?cmgzr Route_to_IPO_TLS | View Clone Edit Delete
< >

7. Ironton SIP Trunking Service Configuration

To use Ironton SIP Trunk service, a customer must request the service from Ironton using the
established sales processes. The process can be started by contacting Ironton via the corporate web

site at: https://www.ironton.com/ and requesting information.

During the signup process, Ironton and the customer will discuss details about the preferred method
to be used to connect the customer’s enterprise network to Ironton’s network.

The customer will need to provide the public IP address used to reach the Avaya Session Border

Controller for Enterprise (Avaya SBCE).

Ironton will provide the customer the necessary information to configure Avaya IP Office and the
Avaya Session Border Controller for Enterprise following the steps discussed in the previous

sections, including:
e FQDN to be use for public DNS record queries.

e SIP Trunk registration credentials (User Name, Password, etc.).

e DID numbers.
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8. Verification and Troubleshooting

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly. This section also provides a list of useful troubleshooting tips that can be
used to troubleshoot the solution.

8.1 Verification Steps

The following steps may be used to verify the configuration:
e Verify that endpoints at the enterprise site can place calls to the PSTN.
e Verify that endpoints at the enterprise site can receive calls from the PSTN.
o Verify that users at the PSTN can end active calls to endpoints at the enterprise by hanging
up.
e Verify that endpoints at the enterprise can end active calls to PSTN users by hanging up.

8.2 IP Office System Status
The following steps can also be used to verify the configuration.

Use the Avaya IP Office System Status application to verify the state of SIP connections. Launch the
application from Start - Programs - IP Office - System Status on the PC where Avaya IP
Office System Status is installed, log in with the proper credentials.

AVAyA IP Office System Status

Help Exit About

Online | offline

Logon

T VLT T G [ 192.168.128.167 -

Services Base TCP Port: il

User Name: userna.me123|

Password:

W Auto reconnect

[l Secure connection
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Select the SIP Line of interest from the left pane. On the Status tab in the right pane, verify that the
Current State is Idle for each channel (assuming no active calls at present time).

IP Office System Status

SIP Trunk Summary
Lire: Servace State: In S
e Do Marmee: B 00 50 14T
Egsabotd Address: 1054 300 13
ure Humber: 17
Humber of Admrtered Oharveis: i
Humber of Chanrels in Lise- 2
Adermiened Compy elman: G710 b, GT2 A
Erglie Fasiiard: off
Sl SUpOT el o
Minda Sreas: STF
Layes 4 Proasos: P
5P Trunk Cranrel Loerme k] . -
SIP Truni Ol Loerees i Use: -]
5P Derecr Peabturer: UPTWATT (Enooming snd Dhztgong])

1 1de | exan

2 e Lday 821127

] \de | rdayosE® |
[ Ide | bdayomiEes |
5 Ide | tdayomigds |
] e | Vdayemi |
7 ide | ideveruen |
] e 1 day 00- 18048

[ 1de | rdayoraie |
[ Ide | rdayorames |
[ Teacess | [ Pmme |[ Png || cotvewss || GescedidSwasen | [ Foroeoutefervee | [ Punt. | [ seess. |

e Select the Alarms tab and verify that no alarms are active on the SIP Line.

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

Status  Utilization Summary Alarms

-5 Alarms for Line: 17 SIP voip.centurylink.com

Last Date Of Error Ocourrences Error Description
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8.3 IP Office Monitor

The IP Office Monitor application can be used to monitor and troubleshoot signaling messaging on
the SIP trunk. Launch the application from Start - Programs > IP Office - Monitor on the PC
where IP Office Manager was installed. Click the Select Unit icon on the taskbar and Select the IP
address of the IP Office system under verification.

Iﬂ_ Avaya IP Office SysMonitor - [STOPPED]
File Edit “iew Filkers Status Help

=8| »lE[T| X[F =

&< | mm

N

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting the desired color.

IS0OM ] Ke_l,l.fLamp] Direch:ur_l,l] tedia ] PP ] RZ ] Houting] Semvices S_I,Istem]

[ Al Settings — [S==)
T1 | YPN | WAN | SCH | Jade |
a4TM | Cal | DTE | EConf | FameRelsy | GOD | H322 | Intedace |

Events
¥ Sip [Vebow = ™ STUN [ SIP Dect
Packets
[~ 5IP Reg/Opt Rx [~ SIF Misc Rx
[ SIP Reg/Opt Tx [ SIP Misc Tx
[~ SIPCallRx [~ Cm Motify Rx
[~ SIPCall T [~ Crn Motify Tx
* Sip Rx IF Filter [nnn.nnn.nnmn.nnmn)
W Sip Tx |
Default Al ‘ Clear Al ‘ Tab Clear ﬁll‘ Tab semu| Cancel
ezl ‘ Lozl ‘ Lozl File| el il ‘
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8.4 Avaya Session Border Controller for Enterprise

There are several links and menus located on the taskbar at the top of the screen of the web interface
that can provide useful diagnostic or troubleshooting information.

Alarms: Provides information about the health of the Avaya SBCE.

Alarms  Incidents

Status v

Users

Logs v

Diagnostics

Settings ~ Help v Log Out

Global Parameters

Domain Policies
TLS Management
Device Specific Settings

Session Border Controller for Enterprise

Dashboard System Management

Administration

Backup/Restore

Devices H Updates U SSL VPN U Licensing U Key Bundles I

AVAYA

Device Name B Version Status
Global Profiles P
PPM Services Avaya_SBCE :'5253'20’11’ Commissioned Reboot Shutdown Restart Application View Edit Uninstall

The following screen shows the Alarm Viewer page.

Devices

EMS

Avaya SBCE

Alarm Viewer

Alarms

AVAYA

M D Details State Time

No alarms found for this device.

| Clear Selected || Clearaul |

Device

Incidents: Provides detailed reports of anomalies, errors, policies violations, etc.

Alarms  Incidents

Status ~

Users

Logs v

Diagnostics

Settings v Help ~  Log Out

Global Parameters

Domain Policies
TLS Management
Device Specific Setlings

Session Border Controller for Enterprise

Dashboard System Management

Administration

Backup/Restore

Devices “ Updates U SSL VPN H Licensing “ Key Bundles I

AVAYA

Device Name m‘anagement Version Status
Global Profiles
PPM Services Avaya_SBCE ;"5253'20'11' Commissioned Reboot Shutdown Restart Application View Edit Uninstall
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The following screen shows the Incident Viewer page.

Incident Viewer AVAYA

Device [ Avaya_SBCE V| Category [Licensing ~| [ ClearFilters Refresh || Generate Report |

Displaying results 0 to 0 out of 0.

Date [up] Time [up] Category

No incidents found.

Diagnostics: This screen provides a variety of tools to test and troubleshoot the Avaya SBCE
network connectivity.

Alarms  Incidents  Statusv  Logs~  Diagnostics  Users Settings v Help v Log Out

Session Border Controller for Enterprise AVAYA
Dashboard System Management
Administration
Backup/Restore
System Management Devices |l Updates I { SSL VPN H Licensing H Key Bundles I

Global Parameters

Device Name B Version Status
Global Profiles P
PPM Services Avaya_SBCE :'5253'20’11’ Commissioned Reboot Shutdown Restart Application View Edit Uninstall

TLS Management

[
¥
[
> Domain Policies
[
[

Device Specific Settings

The following screen shows the Diagnostics page with the results of a ping test.

Pinging 192.168.128.167 X

Average ping from 10.64.101.244 [A1] to 192.168.128.167 is 66.293ms.
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Additionally, the Avaya SBCE contains an internal packet capture tool that allows the capture of
packets on any of its interfaces, saving them as pcap files. Navigate to Device Specific Settings =
Troubleshooting = Trace. Select the Packet Capture tab, set the desired configuration for the
trace and click Start Capture.

Alarms  Incidents  Status~  Logs~  Diagnostics  Users Settings v Help ~  Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Trace: Avaya_SBCE
Administration
Backup/Restore
Devices
System Management _ | Packet Capture | Sats I
Avaya_SBCE
Global Parameters Packet Capture Configuration
Global Profiles Status Ready
PPM Services
Domain Policies Interface
TLS Management Local Address [ann vl |
IP[:Porf]
4| Device Specific Settings
Remote Address ‘g
Network Management * =Port, IP, IP-Part
Media Interface Protacol
Signaling Interface
End Point Flows Maximum Number of Packets to Capture 10000
Session Flows Capture Filename
usinpg the name of an existing capture will overwrite it ‘Claro.pcap
DMZ Services
TURNSTUN Service
SNMP

Syslog Management
Advanced Options

4| Troubleshooting

Debugging
DoS Learning
Logs Collection
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Once the capture is stopped, click on the Captures tab and select the proper pcap file. Note that the
date and time is appended to the filename specified previously. The file can now be saved to the
local PC, where it can be opened with an application such as Wireshark.

Alarms 1 Incidents  Status v Logs~  Diagnostics Users Settings Help ~  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Trace: Avaya_SBCE
Administration

Backup/Restore

System Management Packet Capture || Captures |

> Global Parameters Avaya SBCE
> Global Profiles
> PPM Services

> Domain Policies

File Name File Size (bytes) Last Modified

Ironton_DNS_20180904165239.pcap 24,576 September 4, 2018 4:53:568 PM EDT| Delete

> TLS Management

:
Network Management
Media Interface
Signaling Interface
End Point Flows
Session Flows
> DMZ Services
TURN/STUN Service
SNMP
Syslog Management
Advanced Options

4 |Troubleshooting

Debugging

DoS Learning
Logs Collection
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9. Conclusion

These Application Notes describe the configuration steps necessary for configuring Session
Initiation Protocol (SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office
Release 11.0 and the Avaya Session Border Controller for Enterprise Release 7.2.2 to interoperate
with Ironton SIP Trunking Service, as shown in Figure 1.

Ironton SIP Trunking Service passed compliance testing with the observations/limitations outlined in
the scope of testing in Section 2.1 as well as under test results in Section 2.2.
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